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Déclaration de conformité
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électromagnétique :
• FCC Partie 15 Classe B
• EN 55022 
• EN 55204 
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• CISPR 22 Classe B

Interférence radio et télévision
Cet équipement a été testé et s'est révélé conforme aux 
limites d'un périphérique numérique de classe A, 
conformément aux règlements Part 15 de la FCC.

DECLARATION DE CONFORMITE
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déclarons sous notre seule responsabilité que le produit
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est conforme aux règlements FCC Part 15. 

Son utilisation est soumise aux deux conditions suivantes : 
(1) cet équipement ne peut provoquer d'interférences 
nuisibles, et (2) cet équipement doit supporter toute 
interférence reçue, y compris les interférences susceptibles 
de provoquer un mauvais fonctionnement.
REMARQUE : cet équipement a été testé et s'est révélé 
conforme aux limites d'un périphérique numérique de classe 
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contre les interférences nuisibles dans une installation 
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installé et utilisé conformément aux instructions fournies, il 
peut provoquer des interférences nuisibles aux 
communications radio. Toutefois, aucune garantie n'est 
donnée que des interférences ne se produiront pas dans une 
installation particulière. Si cet équipement produit des 
interférences nuisibles à la réception de postes de radio ou de 
télévision, ce qui peut être décelé en allumant et en éteignant 
le poste, l'utilisateur peut tenter de corriger ces interférences 
en mettant en œuvre une ou plusieurs des mesures 
suivantes :
• réorienter ou déplacer l'antenne de réception ;
• éloigner l'équipement du poste récepteur ;
• connecter l'équipement à une prise électrique différente de 

celle du poste de réception ;
• Demander conseil au revendeur ou à un technicien 

radio/TV expérimenté.

Toute modification de l'équipement, si elle n'est pas 
expressément approuvée par Digidesign, peut annuler le droit 
d'exploitation de l'utilisateur.

Déclaration de conformité pour le Canada
Cet appareil numérique de classe B est conforme à la norme 
ICES-003 du Canada.

Cet appareil numérique de classe B est conforme à la norme 
NMB-003 du Canada.
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Conformité européenne

Ce symbole figurant sur le produit et son conditionnement 
indique que des conditions d'élimination spécifiques 
s'appliquent à ce produit. En effet, il vous incombe d'apporter 
vos équipements usagés à un dépôt de recyclage de matériel 
électrique et électronique. La collecte sélective et le recyclage 
spécifique de vos équipements usagés permettront de 
préserver les ressources naturelles et de protéger 
l'environnement et la santé des populations. Pour plus 
d'informations sur les lieux de collecte et de recyclage de vos 
équipements usagés, veuillez contacter votre service de 
recyclage municipal ou le revendeur local auprès de qui vous 
avez effectué votre achat.





   

table des matières

                                                      
Chapitre 1. Bienvenue dans le système Mbox 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

Coffret Mbox 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

Fonctions de Mbox 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2

Fonctions de Pro Tools LE  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2

Configuration requise  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3

Enregistrement auprès de Digidesign  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

A propos des guides Pro Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

A propos de www.digidesign.com . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

Chapitre 2. Configuration Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Présentation de l'installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Optimisation du système Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Configuration et maintenance du disque dur . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Installation de Pro Tools LE et Mbox 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Logiciels facultatifs du CD d'installation Pro Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14

Lancement de Pro Tools LE  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Configuration de Pro Tools LE. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16

Désinstallation de Pro Tools LE. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Chapitre 3. Configuration Macintosh  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Présentation de l'installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Optimisation du système Macintosh . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21

Configuration et maintenance du disque dur . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

Installation de Pro Tools LE  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Logiciels facultatifs du CD d'installation Pro Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

Connexion de Mbox 2 à l'ordinateur  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

Lancement de Pro Tools LE  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Configuration de Pro Tools LE. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Désinstallation de Pro Tools LE. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
Table des matières v



  

vi

                                                          
Chapitre 4. Matériel et connexions au système Mbox 2  . . . . . . . . . . . . . . . . . . . . . . .  33

Caractéristiques du panneau avant de Mbox 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Caractéristiques du panneau arrière de Mbox 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40

Etablissement de connexions de signaux avec Mbox 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Chapitre 5. Utilisation de Pro Tools LE  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47

Notions de base sur les sessions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47

Commandes de transport . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54

Pistes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55

Liste des régions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58

Mode d'accès à un emplacement à l'intérieur d'une session. . . . . . . . . . . . . . . . . . . . . . . . .  59

Importation de données dans les sessions Pro Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

Enregistrement de base  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65

Edition  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  70

Mixage  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  74

Plug-In  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  77

Automation du mixage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  78

Mixage final . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  79

Annexe A. Configuration de MIDI Studio Setup (Windows uniquement) . . . . . . . . . .  81

MIDI Studio Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81

Prise en charge de noms de patch MIDI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  83

Annexe B. Configuration d'AMS (Mac OS X uniquement). . . . . . . . . . . . . . . . . . . . . . .  85

Audio MIDI Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85

Prise en charge de noms de patch MIDI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  88

Annexe C. Dépannage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89

Sauvegarde de votre travail . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89

Problèmes courants . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89

Facteurs de performances. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  90

Avant d'appeler le support technique de Digidesign . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  91

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  93
Guide Introduction à Mbox 2



           
chapitre 1

Bienvenue dans le système Mbox 2
Bienvenue dans le système Mbox 2, le micro 
studio portable de Digidesign fonctionnant en 
tandem avec Pro Tools.

Avec Mbox 2, votre ordinateur équipé d'un 
port USB dispose de deux canaux d'E/S audio 
analogique, deux canaux d'E/S audio 
numérique, de ports d'E/S MIDI, de sorties 
d'écoute analogiques et d'une sortie casque avec 
commande de réglage sur le panneau avant. 
Mbox 2 intègre des préamplificateurs micro 
de qualité professionnelle et des convertisseurs 
analogiques-numériques et numériques-
analogiques 24 bits. 
Coffret Mbox 2
Le coffret Mbox 2 contient les éléments 
suivants :

• interface audio de bureau Mbox 2 ;

• les CD d'installation contenant le logiciel 
Pro Tools LE, les plug-in DigiRack RTAS 
(Real-Time AudioSuite) et AudioSuite, des 
logiciels facultatifs et les guides en ligne au 
format PDF ;

• le présent guide Introduction à Mbox 2, qui 
inclut des instructions d'installation et de 
configuration du système Mbox 2, ainsi 
qu'une introduction au logiciel Pro Tools LE ;

• le guide Notions de base de Mbox 2, conçu 
pour fournir aux nouveaux utilisateurs 
des méthodes spécifiques pour exécuter 
des tâches courantes, telles qu'importer et 
exporter du son vers et depuis votre Mbox 2, 
connecter un instrument ou un micro et 
enregistrer une session ;

• le câble du connecteur USB ;

• une carte d'enregistrement Digidesign.
Chapitre 1 : Bienvenue dans le système Mbox 2 1
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Fonctions de Mbox 2
Mbox 2 contient les éléments suivants :

• deux canaux d'entrée audio analogiques dotés 
de préamplis micro et d'une alimentation 
fantôme 48V commutable ;

• les prises d'entrée analogique incluent un 
connecteur XLR et deux connecteurs 1/4 de 
pouce (TRS et TS) avec niveaux DI, ligne et 
micro commutables ;

• –20 une touche Pad dB est disponible sur 
chaque canal d'entrée analogique ;

• deux canaux d'entrée et de sortie numériques 
S/PDIF ;

• Les entrées S/PDIF sont disponibles de 
manière indépendante et s'ajoutent aux 
entrées analogiques 1 et 2.

• Les sorties S/PDIF dupliquent les sorties 
analogiques 1 et 2.

• jusqu'à quatre canaux d'entrée (utilisation 
simultanée des entrées analogiques et 
numériques) ;

• un port d'entrée et un port de sortie MIDI, 
fournissant 16 canaux d'entrée MIDI et 
16 canaux de sortie MIDI ;

• deux sorties d'écoute analogiques TRS 1/4 de 
pouce ;

• des convertisseurs N/A et A/N 24 bits 
acceptant des fréquences d'échantillonnage 
de 44,1 kHz et 48 kHz

• un mode d'écoute en enregistrement 
analogique à latence zéro avec équilibrage 
réglable entre l'entrée et la lecture ;

• une touche Mono pour une écoute améliorée 
des sources d'entrée mono (sans incidence sur 
l'enregistrement) ;

• une sortie casque stéréo de 1/4 de pouce (TRS) 
ou de 1/8 de pouce avec commande des 
niveaux réglable ;
Guide Introduction à Mbox 2
• alimentation par USB.

Fonctions de Pro Tools LE
Pro Tools LE 7.0 sous Windows ou Macintosh 
intègre les fonctions ci-dessous avec Mbox 2 :

• lecture de 32 pistes audio numériques 
mono et lecture de 28 pistes pendant 
l'enregistrement de 4 pistes (maximum), 
selon les possibilités de l'ordinateur ;

• jusqu'à 128 pistes audio (dont un 
maximum de 32 pistes pouvant héberger 
des voix), 128 pistes d'entrée auxiliaire, 
64 pistes de fader principal, 256 pistes 
MIDI et 32 pistes d'instrument par session ;

• résolution audio 16 ou 24 bits, à des 
fréquences d'échantillonnage pouvant 
atteindre 48 kHz ;

• édition et automation de mixage à accès 
aléatoire et non destructif ;

• traitement audio avec 5 plug-in RTAS par 
piste, selon la puissance de l'ordinateur ;

• jusqu'à 5 inserts par piste ;

• jusqu'à 10 départs par piste ;

• jusqu'à 32 bus de mixage internes.

Mbox 2 ne fonctionnera pas correctement s'il 
est connecté à un hub USB passif. Pour un 
fonctionnement correct, utilisez un hub sous 
tension ou un port USB dédié distinct si vous 
devez utiliser un hub pour connecter des 
périphériques USB supplémentaires.

Pro Tools LE utilise le processeur de votre 
ordinateur pour mixer et traiter les pistes 
audio (traitement hôte). Les ordinateurs 
fonctionnant à des vitesses d'horloge plus 
rapides peuvent prendre en charge un plus 
grand nombre de pistes et assurer le 
traitement avec davantage de plug-in.



              
Configuration requise
Mbox 2 peut être utilisé sur un PC Windows 
ou un ordinateur Macintosh approuvé par 
Digidesign qui exécute le logiciel Pro Tools LE. 

Pour connaître la configuration complète 
requise, visitez la page relative à la compatibilité 
sur le site Web de Digidesign, à l'adresse 
www.digidesign.com/compato.

Informations sur la compatibilité

Digidesign ne peut assurer la compatibilité et 
fournir une assistance que pour les matériels et 
les logiciels testés et approuvés par ses soins. 

Pour connaître la liste des ordinateurs, 
systèmes d'exploitation, disques durs et 
périphériques tiers approuvés par Digidesign, 
reportez-vous aux informations de 
compatibilité sur le site Web de Digidesign 
(www.digidesign.com/compato).

Configuration MIDI requise

Mbox 2 inclut un port d'entrée MIDI et un port 
de sortie MIDI fournissant 16 canaux d'entrée et 
16 canaux de sortie dans ce format. 

Pour disposer de ports MIDI supplémentaires, 
ajoutez une interface MIDI au système. 

Les interfaces MIDI USB fonctionnent 
correctement avec les systèmes Pro Tools sous 
Windows et Macintosh. Les interfaces série 
MIDI sont prises en charge sur les systèmes 
Windows uniquement.

Seules les interfaces MIDI USB sont 
compatibles avec les systèmes Pro Tools 
pour Mac OS X. Les adaptateurs de port 
modem-série et les périphériques MIDI ne 
sont pas pris en charge.
Pour obtenir la liste des adaptateurs pris en 
charge, reportez-vous au site Web de Digidesign 
(www.digidesign.com).

Configuration des disques durs

Pour obtenir la liste des disques durs agréés, 
reportez-vous au site Web de Digidesign, à 
l'adresse www.digidesign.com/compato.

Si vous utilisez un disque dur ATA/IDE ou 
FireWire, initialisez-le à l'aide du composant 
Gestionnaire de disques de Windows ou de 
l'utilitaire Disk Utility fourni avec le logiciel 
système Apple de Macintosh.

Enregistrement déconseillé sur le 
lecteur système

Il n'est pas recommandé de réaliser des 
enregistrements sur lecteur du système. 
Les performances d'enregistrement et de lecture 
sur les lecteurs système sont en effet amoindries, 
ce qui se traduit par un nombre inférieur de 
pistes et de plug-in.

L'enregistrement sur le lecteur système n'est 
pas recommandé par Digidesign. Procédez à 
cette opération uniquement si cela s'avère 
nécessaire. 
Chapitre 1 : Bienvenue dans le système Mbox 2 3
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Espace de stockage du disque dur
Guide Introduction à Mbox 2
Les pistes audio mono enregistrées en résolution 16 bits à 44,1 kHz (qualité CD) nécessitent environ 
5 Mo d'espace disque par minute. Les mêmes pistes enregistrées en résolution 24 bits requièrent 
environ 7,5 Mo par minute. 

Les pistes audio stéréo enregistrées en résolution 16 bits à 44,1 kHz (qualité CD) nécessitent environ 
10 Mo d'espace disque par minute. Les mêmes pistes enregistrées en résolution 24 bits requièrent 
environ 15 Mo par minute. 

Le Tableau 1 indique la quantité d'espace disque nécessaire en fonction du nombre et de la durée 
des pistes.
Tableau 1. Espace disque requis pour les pistes audio
Nombre de pistes et durée 16 bits à 
44,1 kHz

16 bits à 
48 kHz

24 bits à 
44,1 kHz

24 bits à 
48 kHz

1 piste mono, 1 minute 5 Mo 5,5 Mo 7,5 Mo 8,2 Mo

1 piste stéréo (ou deux pistes 
mono), 5 minutes

50 Mo 55 Mo 75 Mo 83 Mo

1 piste stéréo (ou deux pistes 
mono), 60 minutes

600 Mo 662 Mo 900 Mo 991 Mo

24 pistes mono, 5 minutes 600 Mo 662 Mo 900 Mo 991 Mo

24 pistes mono, 60 minutes 7 Go 7,8 Go 10,5 Go 11,6 Go

32 pistes mono, 5 minutes 800 Mo 883 Mo 1,2 Go 1,3 Go

32 pistes mono, 60 minutes 9,4 Go 10,4 Go 14 Go 15,4 Go



                       
Enregistrement auprès 
de Digidesign
Passez en revue le formulaire d'enregistrement 
ci-joint et suivez les instructions pour 
enregistrer rapidement votre produit en ligne. 
En vous enregistrant, vous bénéficiez d'une 
assistance technique gratuite ainsi que d'offres 
de mises à jour. Il s'agit donc d'une étape 
importante pour tout nouvel utilisateur.

A propos des guides Pro Tools
Le présent guide Introduction à Mbox 2 explique 
comment installer et utiliser Mbox 2 pour 
enregistrer, éditer et mixer des pistes audio et 
MIDI dans Pro Tools LE. 

Si vous utilisez des stations de travail 
numériques pour la première fois, nous vous 
conseillons de lire les documents suivants :

• Le guide Notions de base de Mbox 2 détaille 
notamment la procédure d'importation et 
d'exportation de son avec Mbox 2, de 
connexion à un micro ou à un instrument, 
d'enregistrement d'une session Pro Tools, 
d'importation sur CD audio et de création d'un 
CD audio à partir d'une session Pro Tools.
Pour obtenir des informations complémentaires, 
reportez-vous aux guides en ligne (au format 
PDF) suivants :

• le Guide de référence Pro Tools , qui offre une 
présentation détaillée du logiciel 
Pro Tools LE ; 

• le Guide des menus Pro Tools, qui répertorie 
tous les menus de Pro Tools ;

• le Guide des plug-in DigiRack, qui explique 
comment utiliser les plug-in RTAS et 
AudioSuite inclus dans Pro Tools LE ; 

• le Guide des plug-in Digidesign, qui explique 
comment utiliser les plug-in facultatifs de 
Digidesign ;

• le Guide DigiBase, qui fournit une description 
détaillée de l'utilisation des bases de données 
et des navigateurs Pro Tools DigiBase pour la 
gestion des données et supports ;

• le document intitulé Raccourcis clavier 
Pro Tools, qui fournit une liste des raccourcis 
clavier utilisés dans Pro Tools LE.

Les versions PDF des guides Pro Tools sont 
installées automatiquement avec Pro Tools LE 
et consultables à partir du menu d'aide (Help) 
de Pro Tools. Pour afficher ou imprimer les 
versions PDF, utilisez Adobe Reader ou Apple 
Preview.

Pour vous procurer des copies imprimées 
du Guide de référence Pro Tools et d'autres 
documents, visitez DigiStore, à l'adresse 
www.digidesign.com.
Chapitre 1 : Bienvenue dans le système Mbox 2 5
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Conventions utilisées dans 
ce guide

Les guides de Digidesign utilisent les 
conventions suivantes pour indiquer les 
commandes de menus et les touches de 
raccourci :
:

Les symboles suivants sont utilisés pour mettre 
en évidence des informations importantes :

Convention Action

File > Save Dans le menu File, 
sélectionnez Save.

Ctrl+N Maintenez la touche Ctrl 
enfoncée et appuyez sur la 
touche N.

Ctrl+clic Maintenez la touche Ctrl 
enfoncée et cliquez à l'aide 
du bouton de la souris.

Clic droit (Windows) Cliquez à l'aide du bouton 
droit de la souris.

Les conseils aux utilisateurs sont des 
astuces qui vous permettent d'optimiser 
l'utilisation de votre système Pro Tools.

Les avertissements importants contiennent 
des informations susceptibles de modifier 
vos données ou les performances du système.

Les raccourcis indiquent des raccourcis 
clavier et souris utiles.

Les renvois dirigent l'utilisateur vers les 
sections correspondantes dans les autres 
guides Digidesign.
Guide Introduction à Mbox 2
A propos de 
www.digidesign.com
Le site Web de Digidesign 
(www.digidesign.com) est la meilleure source 
d'informations pour optimiser votre logiciel 
Pro Tools. Vous trouverez ci-après quelques 
exemples des services et fonctions disponibles 
à cette adresse. 

Enregistrement : dans cette section, vous 
pouvez enregistrer votre produit en ligne. 
Le formulaire ci-joint contient les instructions 
d'enregistrement. 

Support : dans cette section, vous pouvez 
contacter l'assistance technique ou le service 
clientèle de Digidesign, télécharger des mises à 
jour logicielles et les dernières versions des 
manuels en ligne, consulter les documents sur la 
compatibilité avec les différents systèmes 
d'exploitation et la base de recherche en ligne 
(Answerbase) ou vous inscrire au forum de 
discussion Pro Tools (à partir de la section 
Conférences d'utilisateurs Digidesign). 

Formation : devenez un expert Pro Tools certifié, 
étudiez directement en ligne ou découvrez les 
méthodes de formation utilisées dans les centres 
de formation certifiés Pro Tools. 

Produits et Développeurs : découvrez les 
produits Digidesign, nos partenaires de 
développement ainsi que leurs plug-in, 
applications et matériels et téléchargez 
des logiciels démo. 

Actualités et Evénements : accédez aux 
informations de dernière minute publiées par 
l'équipe de Digidesign et inscrivez-vous pour 
obtenir une démo de Pro Tools.

Pour plus d'informations sur les services et 
produits Digidesign, visitez le site Web de la 
société à l'adresse www.digidesign.com. 



chapitre 2

Configuration Windows
Ce chapitre contient des informations propres 
aux systèmes Windows. Si vous souhaitez 
installer Pro Tools sur Macintosh, reportez-vous 
au Chapitre 3, Configuration Macintosh.

Présentation de l'installation
L'installation de Mbox 2 sur un PC Windows 
comprend les étapes suivantes :

1  Optimisation du système Windows, page 7.

2  Installation de Pro Tools LE et Mbox 2, 
page 13.

3  Lancement de Pro Tools LE, page 15.

4  Configuration de Pro Tools LE, page 16.

5  Etablissement des connexions audio et MIDI 
au système Mbox 2. (Pour plus d'informations, 
reportez-vous au Chapitre 4, Matériel et 
connexions au système Mbox 2.)

Avant de procéder à l'installation de cette 
version de l'application, lisez le fichier 
Lisez-Moi que contient le CD d'installation 
Pro Tools.
Optimisation du système 
Windows
Avant de configurer votre ordinateur, 
assurez-vous que vous êtes connecté en tant 
qu'administrateur pour le compte sur lequel 
vous souhaitez installer Pro Tools. Pour tout 
renseignement supplémentaire sur les privilèges 
d'administrateur, reportez-vous à la 
documentation Windows.

Optimisations requises

Pour garantir des performances Pro Tools LE 
optimales, configurez les paramètres suivants 
avant d'installer le logiciel et le matériel 
Pro Tools.

lorsque vous avez terminé de modifier les 
paramètres système Windows, redémarrez 
votre ordinateur.
Chapitre 2 : Configuration Windows 7
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Activation de DMA

L'activation de l'option DMA (Direct Memory 
Access) de votre ordinateur libère de l'espace 
sur la bande passante de l'unité centrale et 
permet à votre ordinateur d'effectuer d'autres 
tâches Pro Tools.

Dans la plupart des cas, l'option DMA est déjà 
activée, car Windows XP détecte et active par 
défaut le mode DMA.

Pour activer l'option DMA sur les disques durs IDE :

1  Sélectionnez Démarrer > Panneau 
de configuration. 

2  En mode Affichage classique, cliquez deux fois 
sur Système.

3  Cliquez sur l'icône Ajout de matériel.

4  Cliquez sur le bouton Gestionnaire de 
périphériques sous Gestionnaire de périphériques.

5  Dans la fenêtre du Gestionnaire de 
périphériques, cliquez deux fois sur Contrôleurs 
ATA/ATAPI IDE, puis sur Canal IDE principal 
pour votre disque dur IDE.

6  Cliquez sur l'onglet Paramètres avancés.

7  Pour chaque disque, définissez le mode de 
transfert sur DMA si disponible, puis cliquez 
sur OK.

8  Répétez les étapes 5 à 7 pour tout canal IDE 
supplémentaire.

9  Fermez la fenêtre Gestion de l'ordinateur.
Guide Introduction à Mbox 2
Désactivation de la mise en veille et 
de la gestion de l'alimentation

Lorsque vous utilisez Pro Tools, le mode de mise 
en veille du système Windows doit être défini 
sur Toujours actif. Ceci réduit le risque qu'une 
longue session d'enregistrement ou de lecture 
s'arrête inopinément à cause de la mise hors 
tension des ressources système. 

Pour configurer la gestion de l'alimentation 
Windows :

1  Sélectionnez Démarrer > Panneau de 
configuration.

2  Cliquez deux fois sur Options d'alimentation.

3  Cliquez sur l'onglet Modes de gestion de 
l'alimentation.

4  Dans le menu contextuel Modes de gestion de 
l'alimentation, sélectionnez Toujours actif.

5  Cliquez sur OK. 

Ceci définit les options de mise en veille, de 
mise en veille prolongée et d'arrêt des disques 
durs sur Jamais.

Avec les processeurs AMD, veillez à 
désactiver l'option Cool N’Quiet du BIOS 
(sous AMD Cool N' Quiet Configuration). 
Pour connaître la procédure de désactivation 
de l'option d'alimentation, reportez-vous à 
la documentation du fabricant, le cas 
échéant.



Désactivation du lissage de la police 
ClearType

Lorsque vous utilisez Pro Tools, le paramètre 
Clear Type dans Effets doit être désactivé.

Pour désactiver le lissage de la police ClearType :

1  Sélectionnez Démarrer > Panneau de 
configuration. 

2  Cliquez deux fois sur Affichage.

3  Cliquez sur l'onglet Apparence.

4  Cliquez sur Effets.

5  Désélectionnez l'option Utiliser la méthode 
suivante pour lisser les bords des polices écran.

6  Pour enregistrer vos paramètres et fermer la 
boîte de dialogue Effets, cliquez sur OK.

7  Cliquez sur OK.

8  Redémarrez l'ordinateur. 

Optimisations recommandées

D'autres pilotes logiciels et matériels installés sur 
votre ordinateur peuvent également interférer 
avec Pro Tools. Il est donc conseillé d'effectuer 
les opérations suivantes :

• Evitez d'exécuter simultanément Pro Tools 
et des programmes dont vous n'avez pas 
absolument besoin.

• Désactivez les logiciels qui fonctionnent en 
tâche de fond, tels que Windows Messenger, 
les calendriers et les programmes de 
maintenance de disque. 

• Lorsque vous exécutez Pro Tools, éteignez 
tous les périphériques USB qui ne sont pas 
indispensables. 
• Si votre carte vidéo le permet, activez le 
contrôle de bus (Bus Mastering) dans le 
Panneau de configuration du fabricant. 
Pour plus d'informations, consultez la 
documentation du fabricant.

Optimisations facultatives

Les optimisations du système suivantes peuvent 
améliorer les performances de Pro Tools 
sur certains systèmes. Il est recommandé de 
ne recourir à ces optimisations qu'en cas de 
nécessité, car elles peuvent désactiver ou 
compromettre certaines fonctionnalités des 
autres programmes installés sur votre système.

Désactivation des cartes réseau

Désactivez toutes les cartes réseau de votre 
système, à l'exception des cartes FireWire 
que vous pourriez être amené à utiliser pour 
connecter un disque externe à votre système.

Pour désactiver une carte réseau :

1  Cliquez avec le bouton droit de la souris sur 
Poste de travail, puis sélectionnez Gérer.

2  Dans Outils système, choisissez Gestionnaire 
de périphériques.

3  Dans la fenêtre du Gestionnaire de 
périphériques, cliquez deux fois sur Cartes 
réseau, puis sur la carte réseau à désactiver.

4  Dans l'onglet Général, choisissez Ne pas 
utiliser ce périphérique (activer) dans le menu 
contextuel Utilisation du périphérique, puis 
cliquez sur OK.

5  Fermez la fenêtre Gestion de l'ordinateur.
Chapitre 2 : Configuration Windows 9
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Réglage des performances des 
applications

Pour régler les performances des applications :

1  Sélectionnez Démarrer > Panneau de 
configuration.

2  En mode Affichage classique, cliquez deux fois 
sur Système. 

3  Cliquez sur l'onglet Avancé.

4  Dans la zone Performances, cliquez sur le 
bouton Paramètres.

5  Dans la fenêtre Options de performances, 
cliquez sur l'onglet Avancé.

6  Dans la section Performance des applications, 
sélectionnez l'option Services d'arrière-plan.

7  Dans Utilisation de la mémoire, sélectionnez 
Le cache système.

8  Cliquez sur OK pour fermer la fenêtre Options 
de performances. 

9  Cliquez sur OK pour fermer la fenêtre 
Propriétés système.

10  Redémarrez l'ordinateur pour que les 
modifications prennent effet.

Désactivation de l'Hyper-Threading

Pour le traitement RTAS, Pro Tools LE 7.0 tire 
profit de la puissance supplémentaire des 
ordinateurs équipés de plusieurs processeurs 
ou disposant de la fonction de traitement 
multicœur ou Hyper-Threading. 
Guide Introduction à Mbox 2
Cependant, si vous définissez le nombre de 
processeurs disponibles pour le traitement RTAS 
sur 1 (dans la boîte de dialogue Playback Engine 
de Pro Tools), certains ordinateurs disposant de 
la fonction Hyper-Threading pourront 
enregistrer une baisse de leurs performances.

Si tel est le cas, vous pouvez définir un nombre 
supérieur de processeurs RTAS ou désactiver la 
fonction Hyper-Threading sur l'ordinateur. 

Pour plus d'informations sur la procédure vous 
permettant d'accéder au BIOS de l'ordinateur et 
de désactiver la fonction Hyper-Threading, 
reportez-vous à votre documentation matérielle.

Désactivation des éléments de 
démarrage du système

Les ressources disponibles pour Pro Tools 
dépendent du nombre d'éléments en cours 
d'utilisation sur votre ordinateur. Certaines 
applications de démarrage consomment 
inutilement les ressources du processeur et 
devraient être désactivées. 

Soyez prudent au moment de désactiver les 
éléments de démarrage suivants :

• le numéro de série d'un support portable 
requis pour les applications nécessitant une 
clé de protection contre la copie ;

• la carte plug and play ;

• le rapport des activités ;

• les services cryptographiques ;

• le client DHCP, TCP/IP Net BIOS et autres 
éléments liés au réseau, sauf si l'ordinateur 
n'est pas doté de connexion réseau ou 
Internet. Dans ce cas, ces éléments peuvent 
être désactivés.



Pour désactiver les éléments de démarrage du 
système :

1  Dans le menu Démarrer, choisissez Exécuter.

2  Entrez msconfig et cliquez sur OK. L'utilitaire 
de configuration du système s'ouvre.

3  Sous l'onglet Général, choisissez Démarrage 
sélectif.

4  Désactivez l'option Charger les éléments de 
démarrage, puis cliquez sur OK.

5  Cliquez sur Redémarrer pour redémarrer 
l'ordinateur.

6  Après le redémarrage, un message relatif à la 
configuration système s'affiche à l'écran. Vérifiez 
que les performances de Pro Tools ont été 
améliorées avant de désactiver la case Ne plus 
afficher ce message. Si les performances ne sont 
pas plus satisfaisantes, exécutez la commande 
msconfig et sélectionnez le mode de démarrage 
normal au lieu du mode de démarrage sélectif 
ou désactivez un par un les éléments lancés au 
démarrage et les processus non indispensables. 

Configuration et maintenance 
du disque dur
Il est recommandé de démarrer avec un lecteur 
audio venant d'être initialisé. Il est également 
conseillé de défragmenter périodiquement le 
lecteur audio pour garantir des performances 
stables.

Avant de lancer le lecteur, effectuez une 
sauvegarde des données importantes qu'il 
contient, car toutes les données seront 
supprimées.
Enregistrement déconseillé sur le 
lecteur système

Il n'est pas recommandé de réaliser des 
enregistrements sur lecteur du système. En effet, 
les performances d'enregistrement et de lecture 
sur un lecteur système sont amoindries, ce qui se 
traduit par un nombre inférieur de pistes et de 
plug-in.

Formatage d'un lecteur audio

Pour des performances optimales, les lecteurs 
audio doivent être au format FAT32 ou NTFS. 

Pour formater un lecteur audio :

1  Cliquez avec le bouton droit de la souris sur 
Poste de travail, puis sélectionnez Gérer. 

2  Sous Stockage, sélectionnez Gestion des 
disques.

3  Dans la fenêtre de gestion des disques, cliquez 
avec le bouton droit de la souris sur le disque dur 
que vous utiliserez pour l'audio et choisissez 
Formater.

Fenêtre de gestion des disques (Windows XP)
Chapitre 2 : Configuration Windows 11
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4  Effectuez l'une des opérations suivantes : 

• Sélectionnez l'option Formatage rapide, 
qui convient aux mécanismes agréés. 

– ou –

• Pour optimiser les performances du 
disque, sélectionnez 32 Ko dans le menu 
contextuel Taille d'unité d'allocation. 
Assurez-vous de désélectionner le 
formatage rapide. Bien que plus lente, 
cette option peut améliorer sensiblement 
l'enregistrement et la lecture à partir 
du disque.

5  Cliquez sur Démarrer et suivez les instructions 
à l'écran.

6  Lorsque le formatage est terminé, fermez la 
fenêtre. 

Lecteurs audio et nettoyage du disque

L'enregistrement et l'édition peuvent 
rapidement altérer les performances générales 
du disque. Nous vous conseillons d'utiliser 
régulièrement la fonction Nettoyage de disque 
(ou tout utilitaire équivalent) pour évaluer l'état 
des lecteurs et, si cela est nécessaire, supprimer 
des fichiers temporaires et d'autres données 
inutiles. 

Pro Tools prend uniquement en charge les 
lecteurs de base.
Guide Introduction à Mbox 2
Pour utiliser le Nettoyage de disque : 

1  Sélectionnez Démarrer > Panneau de 
configuration.

2  Cliquez deux fois sur Outils d'administration. 

3  Cliquez deux fois sur Gestion de l'ordinateur.

4  Cliquez deux fois sur Stockage.

5  Cliquez deux fois sur Gestion des disques. 

6  Dans la liste, sélectionnez un volume, puis 
choisissez Fichier > Options. 

Le nettoyage de disque détermine la façon dont 
l'état actuel du disque altère les performances 
et permet de supprimer des fichiers inutiles du 
volume sélectionné. Pour plus d'informations, 
reportez-vous à la documentation Windows XP. 

Défragmentation d'un lecteur audio

Pensez à défragmenter régulièrement les lecteurs 
audio afin de stabiliser les performances du 
système. 

Pour défragmenter un lecteur audio :

1  Cliquez avec le bouton droit de la souris sur 
Poste de travail, puis sélectionnez Gérer.

2  Sous Stockage, sélectionnez Défragmenteur de 
disque.

3  Dans la fenêtre de défragmentation de disque, 
sélectionnez le lecteur que vous souhaitez 
défragmenter.

4  Cliquez sur Défragmenter et suivez les 
instructions à l'écran.

5  Lorsque la défragmentation est terminée, 
fermez la fenêtre Gestion de l'ordinateur.



Installation de Pro Tools LE 
et Mbox 2

Pour installer de Pro Tools LE : 

1  Démarrez Windows en vous connectant 
avec des privilèges d'administrateur. Pour 
tout renseignement supplémentaire sur les 
privilèges d'administrateur, reportez-vous à 
la documentation Windows.

2  Raccordez l'extrémité la plus fine du câble USB 
fourni au port USB de l'unité Mbox 2.

3  Connectez l'autre extrémité du câble USB à 
tout port USB disponible sur votre ordinateur. 
Lorsque la boîte de dialogue de l'assistant Ajout 
de nouveau matériel s'affiche, laissez-la ouverte. 
Ne cliquez pas sur Suivant.

4  Insérez le CD d'installation de Pro Tools LE 
pour Windows dans le lecteur de CD-ROM. 
Recherchez le dossier dans lequel se trouve 
le programme d'installation de Pro Tools, 
ouvrez-le, puis cliquez deux fois sur l'icône 
d'installation.

5  Cliquez sur Suivant pour commencer 
l'installation.

6  Sélectionnez l'emplacement d'installation. 
Pour une fiabilité maximale, installez Pro Tools 
sur le lecteur de démarrage. Cliquez sur Suivant.

7  Sélectionnez les options à installer. Pour 
plus d'informations, reportez-vous à la section 
Logiciels facultatifs du CD d'installation 
Pro Tools, page 14.

Mbox 2 ne fonctionne pas correctement si 
vous le connectez à un hub USB. Si vous 
souhaitez utiliser un hub pour d'autres 
périphériques USB, connectez-le à un autre 
port USB ; le fonctionnement correct du 
système Mbox 2 requiert un port dédié.
8  Cliquez sur Suivant.

9  Attendez que le programme ait installé tous 
les composants logiciels, pilotes et systèmes de 
fichiers PACE pour passer à l'étape suivante. 

10  Une fois l'installation terminée, cliquez sur 
Terminer.

Installation de QuickTime

Procédez à l'installation de QuickTime 6.5 ou 
version ultérieure si vous prévoyez d'inclure 
des fichiers vidéo ou d'importer des fichiers MP3 
ou MP4 (AAC) dans vos sessions Pro Tools. 
Vous pouvez télécharger gratuitement 
QuickTime pour Windows XP sur le site 
Web d'Apple, à l'adresse www.apple.com.

Pour installer QuickTime :

1  Consultez la page QuickTime sur le site 
Internet d'Apple (www.apple.com).

2  Téléchargez le programme d'installation de 
QuickTime sur l'ordinateur.

3  Cliquez deux fois sur le programme et suivez 
les instructions qui s'affichent à l'écran.

4  Redémarrez votre ordinateur.

Si un message d'avertissement vous indique 
que l'essai du logo Windows a échoué, 
cliquez sur Continuer.

Si le voyant USB situé dans le panneau 
avant du système Mbox 2 ne s'allume 
pas après l'installation, débranchez le 
câble USB du port USB de Mbox 2, puis 
rebranchez-le. Si le voyant ne s'allume 
toujours pas, éteignez votre ordinateur, 
débranchez le système Mbox 2, puis 
redémarrez votre ordinateur. Connectez 
ensuite de nouveau le système Mbox 2.
Chapitre 2 : Configuration Windows 13
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Logiciels facultatifs du CD 
d'installation Pro Tools
Le CD d'installation de Pro Tools inclut 
plusieurs options logicielles.

Pilote ASIO Digidesign

Le pilote ASIO (Audio Sound Input Output) de 
Digidesign est un pilote audio multicanal client 
unique qui permet à des programmes audio tiers 
prenant en charge la norme ASIO d'enregistrer 
et de lire des données audio via un dispositif 
Digidesign.

Le pilote ASIO de Digidesign est 
automatiquement installé avec Pro Tools. 

Pilote WaveDriver de Digidesign

WaveDriver de Digidesign est un pilote 
audio stéréo client unique, qui permet à des 
programmes audio tiers compatibles WaveDriver 
MME (Multimedia Extension) de lire des données 
via un dispositif Digidesign.

Pour plus d'informations sur la 
configuration du pilote ASIO de Digidesign, 
reportez-vous au guide correspondant.

Pour une utilisation du pilote ASIO de 
Digidesign sans Pro Tools, installez la 
version autonome du pilote, disponible sur 
le site Web de Digidesign 
(www.digidesign.com).
Guide Introduction à Mbox 2
Le pilote WaveDriver de Digidesign est 
automatiquement installé avec Pro Tools. 

Logiciel Ethernet de Digidesign 
pour prise en charge de surface de 
contrôle
Control|24 uniquement

Si vous prévoyez d'utiliser un système 
Control|24, vous devez installer le logiciel 
Digidesign Ethernet.

Pour installer le logiciel Ethernet de Digidesign :

1  Cliquez sur Démarrer, cliquez avec le bouton 
droit de la souris sur Favoris réseau, puis 
sélectionnez Propriétés. 

2  Cliquez avec le bouton droit sur la Connexion 
au réseau local appropriée, puis choisissez 
Propriétés. 

3  Cliquez sur Installer, sélectionnez Protocole 
puis cliquez sur Ajouter.

4  Cliquez sur Disquette fournie. 

5  Dans le dossier Controllers du CD 
d'installation Pro Tools, sélectionnez le fichier 
DigiNet.inf, puis cliquez sur OK. 

Le programme d'installation installe les fichiers 
DigiNet.inf dans le dossier Program Files\ 
Common Files\Digidesign\DAE\Controllers.

6  Cliquez sur Fermer.

Pour plus d'informations sur la 
configuration du pilote WaveDriver 
de Digidesign, reportez-vous au guide 
correspondant. 

Pour une utilisation du pilote WaveDriver de 
Digidesign sans Pro Tools, installez la version 
autonome du pilote, disponible sur le site 
Web de Digidesign (www.digidesign.com).



Session de démonstration 
Pro Tools

Le CD d'installation de Pro Tools LE comprend 
une session de démonstration permettant de 
vérifier le bon fonctionnement du système.

Pour installer la session de démonstration :

1  Insérez le CD d'installation de Pro Tools LE 
dans le lecteur de CD-ROM. 

2  A partir du lecteur de CD-ROM, recherchez 
le dossier Additional Files/Pro Tools LE Demo 
Session Installer et ouvrez-le.

3  Cliquez deux fois sur Setup.exe.

4  Sélectionnez le disque audio où vous souhaitez 
effectuer l'installation et cliquez sur Install.

5  Une fois l'installation terminée, cliquez sur OK.

MacDrive

L'utilitaire MacDrive vous permet de monter des 
disques au format HFS+ Macintosh sur un 
système Pro Tools Windows et de s'en servir 
comme disques de transfert.

Avant d'installer la session de 
démonstration sur votre lecteur audio, 
vérifiez que ce dernier est configuré comme 
indiqué dans la section Formatage d'un 
lecteur audio, page 11.

Les disques de transfert permettent de 
stocker, mais pas de lire ni d'enregistrer. 
Pour utiliser des fichiers audio pour 
Macintosh sur un système Pro Tools pour 
Windows, copiez les fichiers du lecteur 
audio HFS+ Mac sur un lecteur audio NTFS 
Windows. 
Pour installer la session de démonstration 
MacDrive fournie avec Pro Tools :

1  Insérez le CD d'installation Pro Tools dans le 
lecteur de CD-ROM.

2  A partir du lecteur de CD-ROM, ouvrez le 
dossier Additional Files/ProTools Demo Session 
Installer.

3  Cliquez deux fois sur le programme 
d'installation de la session de démonstration 
MacDrive.

4  Pour procéder à l'installation de MacDrive, 
suivez les instructions à l'écran. Une fois 
l'installation terminée, redémarrez l'ordinateur.

Lancement de Pro Tools LE
Lorsque vous lancez Pro Tools LE pour la 
première fois, vous êtes invité à entrer un code 
d'autorisation.

Pour autoriser le logiciel Pro Tools LE :

1  Cliquez deux fois sur le raccourci Pro Tools LE 
se trouvant sur le bureau ou sur l'icône de 
l'application située dans le dossier Pro Tools, 
qui réside lui-même dans le dossier Digidesign. 

2  Dans la boîte de dialogue qui s'affiche, tapez 
le code d'autorisation exactement tel qu'il est 
imprimé, en insérant les espaces appropriés et 
en respectant la casse, puis cliquez sur Validate. 

Le code d'autorisation est imprimé sur la 
deuxième de couverture de ce guide. 

Les opérations de formatage et de 
maintenance des disques HFS+ doivent 
s'effectuer lorsque les disques sont reliés à 
un Macintosh. N'utilisez pas l'utilitaire 
MacDrive pour initialiser ou partitionner 
des disques Macintosh.
Chapitre 2 : Configuration Windows 15
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Configuration de Pro Tools LE

Paramètres système de Pro Tools

Pro Tools LE permet de modifier les 
performances de votre système en changeant 
les paramètres système qui affectent sa capacité 
lors des opérations de traitement, de lecture et 
d'enregistrement. 

Dans la plupart des cas, les paramètres 
par défaut de votre système assurent des 
performances optimales, mais vous pouvez les 
régler afin que le système puisse prendre en 
charge de longues sessions et des sessions à 
traitement intensif de Pro Tools. 

Taille du buffer matériel

Le paramètre Hardware Buffer Size contrôle 
la taille du buffer utilisé pour effectuer les tâches 
de traitement hôte telles que le traitement des 
effets des plug-in en temps réel (RTAS, Real-Time 
AudioSuite). Le buffer matériel permet 
également de gérer la latence d'écoute.

◆ Des valeurs inférieures réduisent la latence 
d'écoute et sont particulièrement adaptées à 
l'enregistrement des entrées en direct. 

◆ Des valeurs plus élevées permettent 
d'effectuer un traitement audio plus avancé et 
d'appliquer un plus grand nombre d'effets. 
De plus, elles sont utiles lorsque vous mixez et 
que vous utilisez davantage de plug-in RTAS.

Un buffer de grande taille entraîne une 
réponse plus lente de l'écran et une certaine 
latence d'écoute. Il risque aussi d'accroître 
la latence due aux plug-in RTAS et 
d'affecter la précision de l'automation des 
plug-in, les données de coupure (Mute) et la 
synchronisation des pistes MIDI.
Guide Introduction à Mbox 2
Pour modifier la taille du buffer matériel :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu déroulant H/W Buffer Size, 
sélectionnez la taille du buffer audio, exprimée 
en nombre d'échantillons.

3  Cliquez sur OK.

Processeurs RTAS

Le paramètre RTAS Processors permet de 
déterminer le nombre de processeurs de 
votre ordinateur alloués au traitement des 
plug-in RTAS. 

Dans le cas d'ordinateurs équipés de plusieurs 
processeurs ou de la fonction de traitement 
multicœur ou Hyper-Threading, ce paramètre 
vous permet d'activer la prise en charge 
multiprocesseur pour les traitements RTAS. 
Utilisé conjointement avec le paramètre CPU 
Usage Limit, il vous permet de contrôler le 
traitement RTAS et d'autres tâches Pro Tools 
réalisées par le système.

◆ Plus le nombre de processeurs est élevé, 
plus la capacité de traitement des plug-in RTAS 
augmente, ce qui s'avère particulièrement utile 
pour les sessions avec un nombre important de 
plug-in RTAS.

Boîte de dialogue Playback Engine pour Mbox 2



◆ En revanche, un nombre moins important 
de processeurs permet d'améliorer le traitement 
de l'automation, du rafraîchissement d'écran et 
de la lecture vidéo dans Pro Tools, ainsi que le 
traitement de toute autre application s'exécutant 
simultanément.

Pour définir le nombre de processeurs RTAS :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu contextuel RTAS Processors, 
sélectionnez le nombre de processeurs 
disponibles que vous souhaitez allouer au 
traitement des plug-in RTAS.

3  Cliquez sur OK.

Pourcentage d'utilisation du 
processeur

Le pourcentage d'utilisation du processeur 
(CPU Usage Limit) contrôle la proportion des 
ressources de processeur allouées aux tâches 
de traitement hôte de Pro Tools. Utilisé 
conjointement avec le paramètre RTAS 
Processors, il vous permet de contrôler les tâches 
Pro Tools réalisées par le système.

◆ En attribuant une valeur peu élevée au 
paramètre CPU Usage Limit, vous limitez 
l'impact du traitement de Pro Tools sur d'autres 
tâches faisant un usage intensif du processeur, 
comme le rafraîchissement d'écran. Ceci est 
utile lorsque la réponse de système est très lente 
ou que d'autres applications sont en cours 
d'utilisation en même temps que Pro Tools.

◆ Un pourcentage élevé d'utilisation du 
processeur permet d'allouer davantage de 
puissance de traitement à Pro Tools et s'avère 
utile lorsque vous lisez de larges sessions ou que 
vous utilisez davantage de plug-in temps réel. 
Le pourcentage d'utilisation maximum dépend 
du nombre de processeurs sur votre ordinateur 
et du nombre de processeurs dédiés au 
traitement RTAS. Cette valeur se situe entre 
85 % pour un ordinateur à processeur unique et 
99 % pour un ordinateur équipé de plusieurs 
processeurs.

Pour modifier la limite d'utilisation du processeur :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu déroulant CPU Usage Limit, 
sélectionnez le pourcentage de puissance du 
processeur à allouer à Pro Tools. 

3  Cliquez sur OK.

Taille du buffer de lecture DAE

Le paramètre DAE Playback Buffer Size 
détermine la quantité de mémoire DAE allouée 
aux buffers de disque. La taille du buffer de 
lecture DAE maximale pour les opérations de 
disque correspond au niveau 2.

◆ Une taille de buffer de lecture DAE inférieure 
au niveau 2 peut améliorer la vitesse d'amorce 
de lecture et d'enregistrement. En revanche, 
la lecture et l'enregistrement des pistes peuvent 
être altérés si vos sessions contiennent un 
nombre élevé de pistes ou de points d'édition, 
ou si votre système intègre des disques durs lents 
ou très fragmentés.

Il est possible que l'accroissement du 
pourcentage d'utilisation du processeur 
ralentisse l'affichage des écrans et la vitesse 
de traitement des ordinateurs.
Chapitre 2 : Configuration Windows 17
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◆ Une taille supérieure au niveau 2 permet une 
densité d'édition plus élevée au cours d'une 
session ou un nombre de pistes plus important 
lors de l'utilisation de disques durs plus lents. 
Cependant, un niveau élevé peut également 
provoquer un retard lors du démarrage de la 
lecture, ou de l'enregistrement, ou un retard 
audible plus long lors de l'édition en cours de 
lecture.

Pour modifier la taille du buffer de lecture DAE :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu déroulant DAE Playback Buffer, 
sélectionnez une taille de buffer.

3  Cliquez sur OK.

Paramètres matériels Pro Tools

Pro Tools vous permet de définir la fréquence 
d'échantillonnage et la source d'horloge par 
défaut pour votre système, ainsi qu'un ensemble 
de commandes spécifiques à chaque type 
d'interface audio.

Une grande taille de buffer de lecture DAE 
réduit la mémoire système affectée aux 
autres tâches. Nous vous conseillons 
d'utiliser la valeur par défaut (niveau 2) 
à moins que vous ne rencontriez les erreurs 
-9073 de disques trop lents ou trop 
fragmentés. 
Guide Introduction à Mbox 2
Fréquence d'échantillonnage 
par défaut

Le paramètre Sample Rate (fréquence 
d'échantillonnage) s'affiche par défaut lorsque 
vous créez une session. Ce paramètre est 
disponible dans la boîte de dialogue Hardware 
Setup uniquement lorsque aucune session 
n'est ouverte.

Pour modifier la fréquence d'échantillonnage par 
défaut :

1  Sélectionnez Setup > Hardware.

2  Dans le menu déroulant Sample Rate, 
sélectionnez une fréquence d'échantillonnage.

3  Cliquez sur OK.

Vous pouvez modifier la fréquence 
d'échantillonnage lors de la création d'une 
session Pro Tools en sélectionnant une 
fréquence différente dans la boîte de dialogue 
New Session. Pour plus d'informations, 
reportez-vous au Guide de référence 
Pro Tools.

Boîte de dialogue Hardware Setup pour Mbox 2



Source d'horloge

La boîte de dialogue Hardware Setup de 
Pro Tools permet de sélectionner la source 
d'horloge du système (Clock Source).

Internal Ce paramètre vous permet d'enregistrer 
des signaux analogiques directement sur les 
entrées analogiques 1 et 2 de Mbox 2 ou des 
entrées numériques sur les entrées 3 et 4 de 
Mbox 2 pour lesquelles le périphérique 
numérique est synchronisé à la sortie 
numérique Mbox 2.

E/S numériques Ce paramètre vous permet de 
réaliser des enregistrements via les entrées 
S/PDIF de Mbox 2 à partir d'un périphérique 
numérique externe. Il synchronise Pro Tools 
avec le périphérique numérique en question. 

Pour sélectionner la source d'horloge :

1  Sélectionnez Setup > Hardware.

2  Dans le menu déroulant Clock Source, 
sélectionnez une source d'horloge. 

3  Cliquez sur OK. 

Pour que la synchronisation de Pro Tools 
avec le périphérique se réalise avec succès, 
votre périphérique d'entrée numérique doit 
être connecté et sous tension. S'il n'est pas 
sous tension, laissez la valeur Clock Source 
sur Internal.
Configuration de la boîte de 
dialogue I/O Setup

La boîte de dialogue de configuration des E/S 
(I/O Setup) permet de marquer les chemins de 
signaux d'entrée, de sortie, d'insert et de bus de 
Pro Tools LE. Elle fournit une représentation 
graphique de l'assignation des entrées, sorties et 
signaux du système Mbox 2.

Pro Tools LE est livré avec les paramètres I/O 
Setup par défaut, qui vous permettent de 
démarrer. Pour renommer les chemins d'E/S, 
utilisez la boîte de dialogue I/O Setup.

Pour renommer les chemins d'E/S dans I/O 
Setup :

1  Sélectionnez Setup > I/O.

Boîte de dialogue I/O Setup pour Mbox 2
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2  Pour afficher les connexions Input, Output, 
Insert ou Bus, cliquez sur l'onglet 
correspondant.

3  Pour modifier le nom d'un chemin ou d'un 
sous-chemin, cliquez deux fois directement sur 
le nom du chemin, tapez le nouveau nom et 
appuyez sur Entrée. 

4  Cliquez sur OK.

Configuration de MIDI Studio
(facultative)

Si vous décidez d'utiliser des périphériques MIDI 
avec Pro Tools, configurez votre installation 
MIDI avec MIDI Studio Setup. Pour plus 
d'informations, consultez la section Annexe A, 
Configuration de MIDI Studio Setup 
(Windows uniquement).

Sauvegarde de la configuration 
du système

Une fois la configuration de Pro Tools et du 
système terminée, enregistrez une image de 
votre disque système à l'aide d'un utilitaire 
de sauvegarde tel que Norton Ghost. Cette 
opération vous permet, en cas de problèmes, 
de restaurer rapidement la configuration et 
les paramètres de votre système.

Pour obtenir des informations sur 
l'attribution de nouveaux noms aux 
chemins d'E/S, reportez-vous au Guide de 
référence Pro Tools ou sélectionnez Help > 
Pro Tools Reference Guide.
Guide Introduction à Mbox 2
Désinstallation 
de Pro Tools LE
Si vous souhaitez supprimer le logiciel 
Pro Tools LE de votre ordinateur, vous 
pouvez utiliser l'option Ajout/Suppression 
de programmes.

Pour supprimer Pro Tools de votre ordinateur :

1  Sélectionnez Démarrer > Panneau de 
configuration. 

2  Cliquez deux fois sur Ajout/Suppression de 
programmes.

3  Dans la liste Programmes actuellement 
installés, sélectionnez Digidesign Pro Tools LE.

4  Cliquez sur le bouton Modifier/Supprimer.

5  Suivez les instructions à l'écran pour 
supprimer Pro Tools LE.



chapitre 3

Configuration Macintosh
Ce chapitre contient des informations propres 
aux systèmes Macintosh. Si vous souhaitez 
installer Pro Tools sous Windows, reportez-vous 
au Chapitre 2, Configuration Windows.

Présentation de l'installation
L'installation de Mbox 2 sur un ordinateur 
Macintosh comprend les étapes suivantes :

1  Optimisation du système Macintosh, page 21.

2  Installation de Pro Tools LE, page 24.

3  Connexion de Mbox 2 à l'ordinateur, page 25.

4  Lancement de Pro Tools LE, page 26.

5  Configuration de Pro Tools LE, page 26.

6  Etablissement des connexions audio au 
système Mbox 2. (Pour plus d'informations, 
reportez-vous au Chapitre 4, Matériel et 
connexions au système Mbox 2.)

Avant de procéder à l'installation de cette 
version de l'application, lisez le fichier 
Lisez-Moi que contient le CD d'installation 
Pro Tools.
Optimisation du système 
Macintosh

Pour des performances optimales avec 
Pro Tools, configurez l'ordinateur avant 
d'installer le matériel et le logiciel Pro Tools.

Avant de configurer votre ordinateur, 
assurez-vous que vous êtes connecté en tant 
qu'administrateur pour le compte sur lequel 
vous souhaitez installer Pro Tools. Pour obtenir 
des détails sur les privilèges d'administrateur sur 
Mac OS X, reportez-vous à votre documentation 
Apple OS X. 

N'utilisez pas la fonction de mise à jour 
logicielle automatique de Mac OS X, car 
cela risquerait d'entraîner la mise à jour de 
votre système avec une version de Mac OS 
qui n'a pas été validée pour Pro Tools. 
Pour plus d'informations sur les versions 
agréées de Mac OS, reportez-vous aux 
dernières informations de compatibilité, 
disponibles sur le site Web de Digidesign : 
www.digidesign.com/compato.
Chapitre 3 : Configuration Macintosh 21
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Désactivation de la mise à jour 
logicielle

Pour désactiver la fonction de mise à jour 
logicielle :

1  Dans le menu Pomme, sélectionnez 
Préférences Système, puis cliquez sur Mise à jour 
de logiciels. 

2  Cliquez sur Mise à jour de logiciels, puis 
désélectionnez l'option de vérification des mises 
à jour.

Désactivation de l'économiseur 
d'énergie

Pour désactiver la fonction d'économie d'énergie :

1  Dans le menu Pomme, sélectionnez 
Préférences Système, puis cliquez sur 
Economiseur d'énergie.

2  Cliquez sur Suspendre, puis effectuez les 
opérations suivantes :

• Définissez le mode de veille de l'ordinateur 
sur Jamais.

• Définissez le paramètre de veille d'affichage 
sur Jamais.

• Désélectionnez l'option Suspendre dès que 
possible l'activité du ou des disques durs.
Guide Introduction à Mbox 2
Configuration des performances du 
processeur

(ordinateurs Macintosh G5 uniquement)

Pour configurer les performances du processeur :

1  Dans le menu Pomme, sélectionnez 
Préférences Système, puis cliquez sur 
Economiseur d'énergie.

2  Cliquez sur Options et choisissez le niveau de 
performances le plus élevé.

Désactivation de l'indexation Spotlight

En raison de son activité d'indexation des fichiers 
et des dossiers en arrière-plan, la fonction 
Spotlight de Mac OS X a une incidence directe 
sur les performances du système. Il est donc 
conseillé de désactiver l'indexation Spotlight 
avant d'utiliser Pro Tools.

Pour désactiver l'indexation Spotlight :

1  Dans le menu Pomme, sélectionnez 
Préférences Système, puis cliquez sur Spotlight. 

2  Dans la fenêtre Spotlight, cliquez sur 
Confidentialité.

3  Faites glisser l'icône du disque que vous ne 
souhaitez pas indexer du bureau vers la liste.



Désactivation des raccourcis Spotlight

La fonction Spotlight de Mac OS X utilise des 
raccourcis qui servent également au démarrage 
de l'enregistrement (Pomme+barre d'espace) et 
à l'enregistrement en ligne (Pomme+Option+ 
barre d'espace) dans Pro Tools. Pour pouvoir 
user de ces touches dans Pro Tools, vous devez 
donc désactiver les raccourcis de la fonction 
Spotlight.

Pour désactiver les raccourcis clavier de la 
fonction Spotlight :

1  Dans le menu Pomme, sélectionnez 
Préférences Système, puis cliquez sur Spotlight. 

2  Désélectionnez Raccourci clavier du menu 
Spotlight et Raccourci clavier de la fenêtre 
Spotlight.

Désactivation des raccourcis du 
Dashboard

Le Dashboard de Mac OS X utilise des raccourcis 
qui servent également au démarrage de 
l'enregistrement (F12) dans Pro Tools. Pour 
pouvoir user de ces touches dans Pro Tools, vous 
devez donc désactiver les raccourcis du 
Dashboard.

Pour désactiver les raccourcis clavier du 
Dashboard :

1  Dans le menu Pomme, sélectionnez 
Préférences Système, puis cliquez sur Dashboard 
et Exposé. 

2  Définissez le raccourci clavier du Dashboard 
sur « – » pour le désactiver.
Configuration et maintenance 
du disque dur
Il est recommandé de démarrer avec un lecteur 
audio venant d'être initialisé.

Enregistrement déconseillé sur le 
lecteur système

Il n'est pas recommandé de réaliser des 
enregistrements sur lecteur du système. 
Les performances d'enregistrement et de lecture 
sur les lecteurs système sont en effet amoindries, 
ce qui se traduit par un nombre inférieur de 
pistes, de plug-in et d'erreurs de disque.

Formatage d'un lecteur audio

Pour des performances optimales, les lecteurs 
audio doivent être au format Mac OS Extended 
(Journaled). 

L'initialisation du lecteur supprimera 
toutes les données qu'il contient. Par 
conséquent, effectuez auparavant une 
sauvegarde de vos données importantes.
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Pour formater un lecteur audio : 

1  Dans le dossier Applications/Utilitaires, 
démarrez le logiciel Utilitaire de disque.

2  Cliquez sur l'onglet Effacer. 

3  Dans la colonne à gauche de la fenêtre, 
sélectionnez le lecteur à initialiser. 

4  Choisissez le format Mac OS Extended 
(Journaled). 

5  Tapez le nom du nouveau volume. 

6  Si vous envisagez de connecter le lecteur à 
un ordinateur équipé du système d'exploitation 
Mac OS 9, sélectionnez Installer les pilotes 
Mac OS 9. 

7  Cliquez sur Effacer.

Le lecteur intitulé du nom du nouveau volume 
s'affiche sur le bureau.

Utilitaire de disque (Mac OS X)

Ne sélectionnez pas l'option de sensibilité à 
la casse, car Pro Tools ne fonctionnerait pas 
correctement.
Guide Introduction à Mbox 2
Installation de Pro Tools LE
Après avoir configuré les paramètres du logiciel 
système Apple, vous pouvez installer Pro Tools LE.

Pour installer Pro Tools LE sous Mac OS X :

1  Assurez-vous que vous êtes connecté en tant 
qu'administrateur pour le compte sur lequel 
vous souhaitez installer Pro Tools. Pour plus 
d'informations sur les privilèges d'administrateur 
sur Mac OS X, reportez-vous à la documentation 
Mac OS X d'Apple. 

2  Insérez le CD d'installation de Pro Tools LE 
dans le lecteur de CD-ROM. Cliquez deux fois 
sur Install Pro Tools LE.

3  Saisissez votre mot de passe administrateur et 
cliquez sur OK pour authentifier l'installation. 

4  Pour poursuivre l'installation, suivez les 
instructions à l'écran. 

5  Dans la fenêtre du programme d'installation, 
assurez-vous que l'emplacement d'installation 
correspond à votre disque de démarrage. 

6  Dans la fenêtre du programme d'installation, 
choisissez Custom Install dans le menu 
contextuel et cliquez sur Install. 

7  Suivez les dernières instructions à l'écran pour 
installer Pro Tools et les options souhaitées (Voir 
aussi la section Lancement de Pro Tools LE, 
page 26.)

8  Lorsque l'installation est terminée, cliquez sur 
Restart.



Pilote CoreAudio de Mbox 2

Le pilote CoreAudio de Mbox 2 est un pilote 
audio multicanal multiclient qui permet à des 
applications compatibles CoreAudio d'effectuer 
des opérations de lecture et d'enregistrement via 
un périphérique Digidesign. 

Le pilote CoreAudio est installé par défaut 
lorsque vous installez Pro Tools.

Logiciels facultatifs du CD 
d'installation Pro Tools
En outre, le CD d'installation Pro Tools LE 
contient plusieurs programmes d'installation 
pour les options suivantes : 

Session de démonstration 
Pro Tools

Le CD d'installation de Pro Tools LE comprend 
une session de démonstration permettant de 
vérifier le bon fonctionnement du système.

Pour installer la session de démonstration :

1  Insérez le CD d'installation de Pro Tools LE 
dans le lecteur de CD-ROM. Recherchez l'icône 
d'installation des sessions de démonstration et 
cliquez deux fois dessus. 

2  Sélectionnez le disque audio où vous 
souhaitez effectuer l'installation et cliquez 
sur Install.

3  Une fois l'installation terminée, cliquez 
sur Quit.

Pour plus d'informations sur la configuration 
du pilote CoreAudio de Mbox 2, reportez-vous 
au guide correspondant. 
Connexion de Mbox 2 
à l'ordinateur
Avant de lancer le logiciel Pro Tools LE, 
connectez Mbox 2 à l'ordinateur.

Pour connecter Mbox 2 à votre ordinateur :

1  Raccordez l'extrémité la plus fine du câble USB 
fourni au port USB de l'unité Mbox 2.

2  Connectez l'autre extrémité du câble USB à 
tout port USB disponible sur votre ordinateur.

Si le voyant USB situé dans le panneau 
avant du système Mbox 2 ne s'allume pas 
après l'installation, débranchez le câble 
USB du port USB de Mbox 2, puis 
rebranchez-le. Si le voyant ne s'allume 
toujours pas, éteignez votre ordinateur, 
débranchez le système Mbox 2, puis 
redémarrez votre ordinateur. Connectez 
ensuite de nouveau le système Mbox 2.

Mbox 2 ne fonctionne pas correctement si 
vous le connectez à un hub USB. Si vous 
devez absolument utiliser un hub pour 
d'autres périphériques USB, utilisez un port 
hub distinct ; Mbox 2 doit être branché à un 
port dédié sur l'ordinateur pour fonctionner 
correctement.
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Lancement de Pro Tools LE
Lorsque vous lancez Pro Tools LE pour la 
première fois, vous êtes invité à entrer un code 
d'autorisation pour valider votre logiciel. 

Pour autoriser le logiciel Pro Tools LE :

1  Cliquez deux fois sur l'icône Pro Tools LE du 
Dock ou sur l'icône de l'application située dans 
le dossier Pro Tools, qui réside lui-même dans le 
dossier Digidesign. 

2  Dans la boîte de dialogue qui s'affiche, tapez le 
code d'autorisation lorsque vous y êtes invité, 
exactement tel qu'il est imprimé, en insérant les 
espaces appropriés et en respectant la casse, puis 
cliquez sur Validate.

Le code d'autorisation est imprimé sur la 
deuxième de couverture de ce guide. 

Configuration de Pro Tools LE

Paramètres système de Pro Tools

Pro Tools LE permet de modifier les 
performances de votre système en changeant les 
paramètres système qui affectent sa capacité lors 
des opérations de traitement, de lecture et 
d'enregistrement. 

Dans la plupart des cas, les paramètres par défaut 
de votre système assurent des performances 
optimales, mais vous pouvez les régler afin que 
le système puisse prendre en charge de longues 
sessions et des sessions à traitement intensif de 
Pro Tools. 
Guide Introduction à Mbox 2
Taille du buffer matériel

Le paramètre Hardware Buffer Size contrôle la 
taille du buffer utilisé pour effectuer les tâches 
de traitement hôte telles que le traitement des 
effets des plug-in en temps réel (RTAS, Real-Time 
AudioSuite). Le buffer matériel permet 
également de gérer la latence d'écoute.

◆ Des valeurs inférieures réduisent la latence 
d'écoute et sont particulièrement adaptées à 
l'enregistrement des entrées en direct. 

◆ Des valeurs plus élevées permettent 
d'effectuer un traitement audio plus avancé et 
d'appliquer un plus grand nombre d'effets. 
De plus, elles sont utiles lorsque vous mixez et 
que vous utilisez davantage de plug-in RTAS.

Pour modifier la taille du buffer matériel :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu déroulant H/W Buffer Size, 
sélectionnez la taille du buffer audio, exprimée 
en nombre d'échantillons.

3  Cliquez sur OK.

Un buffer de grande taille entraîne une 
réponse plus lente de l'écran et une certaine 
latence d'écoute. Il risque aussi d'accroître 
la latence due aux plug-in RTAS et 
d'affecter la précision de l'automation 
des plug-in, les données de coupure (Mute) 
et la synchronisation des pistes MIDI.

Boîte de dialogue Playback Engine pour Mbox 2



Processeurs RTAS

Le paramètre RTAS Processors permet de 
déterminer le nombre de processeurs de 
votre ordinateur alloués au traitement des 
plug-in RTAS. 

Dans le cas d'ordinateurs équipés de plusieurs 
processeurs ou de la fonction de traitement 
multicœur ou Hyper-Threading, ce paramètre 
vous permet d'activer la prise en charge 
multiprocesseur pour les traitements RTAS. 
Utilisé conjointement avec le paramètre CPU 
Usage Limit, il vous permet de contrôler le 
traitement RTAS et d'autres tâches Pro Tools 
réalisées par le système.

◆ Plus le nombre de processeurs est élevé, plus 
la capacité de traitement des plug-in RTAS 
augmente, ce qui s'avère particulièrement utile 
pour les sessions avec un nombre important de 
plug-in RTAS.

◆ En revanche, un nombre moins important 
de processeurs permet d'améliorer le traitement 
de l'automation, du rafraîchissement d'écran 
et de la lecture vidéo dans Pro Tools, ainsi que 
le traitement de toute autre application 
s'exécutant simultanément.

Pour définir le nombre de processeurs RTAS :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu contextuel RTAS Processors, 
sélectionnez le nombre de processeurs 
disponibles que vous souhaitez allouer au 
traitement des plug-in RTAS.

3  Cliquez sur OK.
Pourcentage d'utilisation du 
processeur

Le pourcentage d'utilisation du processeur 
(CPU Usage Limit) contrôle la proportion des 
ressources de processeur allouées aux tâches 
de traitement hôte de Pro Tools. Utilisé 
conjointement avec le paramètre RTAS 
Processors, il vous permet de contrôler les 
tâches Pro Tools réalisées par le système.

◆ En attribuant une valeur peu élevée au 
paramètre CPU Usage Limit, vous limitez 
l'impact du traitement de Pro Tools sur d'autres 
tâches faisant un usage intensif du processeur, 
comme le rafraîchissement d'écran. Ceci est 
utile lorsque la réponse de système est très lente 
ou que d'autres applications sont en cours 
d'utilisation en même temps que Pro Tools.

◆ Un pourcentage élevé d'utilisation du 
processeur permet d'allouer davantage de 
puissance de traitement à Pro Tools et s'avère 
utile lorsque vous lisez de larges sessions ou que 
vous utilisez davantage de plug-in temps réel. 

Le pourcentage d'utilisation maximum 
dépend du nombre de processeurs sur votre 
ordinateur et du nombre de processeurs dédiés 
au traitement RTAS. Cette valeur se situe entre 
85 % pour un ordinateur à processeur unique 
et 99 % pour un ordinateur équipé de plusieurs 
processeurs.

Il est possible que l'accroissement du 
pourcentage d'utilisation du processeur 
ralentisse l'affichage des écrans et la vitesse 
de traitement des ordinateurs.
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Pour modifier la limite d'utilisation du processeur :

1  Sélectionnez Setup > Playback Engine. 

2  Dans le menu déroulant CPU Usage Limit, 
sélectionnez le pourcentage de puissance du 
processeur à allouer à Pro Tools. 

3  Cliquez sur OK.

Taille du buffer de lecture DAE

Le paramètre DAE Playback Buffer Size 
détermine la quantité de mémoire DAE allouée 
aux buffers de disque. La taille du buffer de 
lecture DAE maximale pour les opérations de 
disque correspond au niveau 2.

◆ Une taille de buffer de lecture DAE inférieure 
au niveau 2 peut améliorer la vitesse d'amorce 
de lecture et d'enregistrement. En revanche, 
la lecture et l'enregistrement des pistes peuvent 
être altérés si vos sessions contiennent un 
nombre élevé de pistes ou de points d'édition, 
ou si votre système intègre des disques durs lents 
ou très fragmentés.

◆ Une taille supérieure au niveau 2 permet une 
densité d'édition plus élevée au cours d'une 
session ou un nombre de pistes plus important 
lors de l'utilisation de disques durs plus lents. 
Cependant, un niveau élevé peut également 
provoquer un retard lors du démarrage de la 
lecture, ou de l'enregistrement, ou un retard 
audible plus long lors de l'édition en cours de 
lecture.

Une grande taille de buffer de lecture DAE 
réduit la mémoire système affectée aux 
autres tâches. Nous vous conseillons 
d'utiliser la valeur par défaut (niveau 2) 
à moins que vous ne rencontriez les erreurs 
-9073 de disques trop lents ou trop 
fragmentés. 
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Pour modifier la taille du buffer de lecture DAE :

1  Sélectionnez Setup > Playback Engine.

2  Dans le menu déroulant DAE Playback Buffer, 
sélectionnez une taille de buffer.

3  Cliquez sur OK.

Paramètres matériels Pro Tools

Avec Pro Tools, vous pouvez définir la fréquence 
d'échantillonnage (Sample Rate) et la source 
d'horloge (Clock Source) par défaut du système. 

Fréquence d'échantillonnage par 
défaut

Le paramètre Sample Rate (fréquence 
d'échantillonnage) s'affiche par défaut lorsque 
vous créez une session. Ce paramètre est 
disponible dans la boîte de dialogue Hardware 
Setup uniquement lorsque aucune session n'est 
ouverte. 

Vous pouvez modifier la fréquence 
d'échantillonnage lors de la création 
d'une session Pro Tools en sélectionnant 
une fréquence différente dans la boîte de 
dialogue New Session. (reportez-vous à la 
section Lancement d'une session, page 47).



Pour modifier la fréquence d'échantillonnage 
par défaut :

1  Assurez-vous qu'aucune session de Pro Tools 
n'est ouverte. 

2  Sélectionnez Setup > Hardware. 

3  Dans le menu contextuel Sample Rate, 
sélectionnez une fréquence d'échantillonnage. 

4  Cliquez sur OK.

Source d'horloge

La boîte de dialogue Hardware Setup de 
Pro Tools permet de sélectionner la source 
d'horloge du système (Clock Source).

Internal Ce paramètre vous permet d'enregistrer 
des signaux analogiques directement sur les 
entrées analogiques 1 et 2 de Mbox 2 ou des 
entrées numériques sur les entrées 3 et 4 
de Mbox 2 pour lesquelles le périphérique 
numérique est synchronisé à la sortie 
numérique Mbox 2.

E/S numériques Ce paramètre vous permet 
de réaliser des enregistrements via les entrées 
S/PDIF de Mbox 2 à partir d'un périphérique 
numérique externe. Il synchronise Pro Tools 
avec le périphérique numérique en question. 

Boîte de dialogue Hardware Setup pour Mbox 2
Pour sélectionner la source d'horloge :

1  Sélectionnez Setup > Hardware.

2  Dans le menu déroulant Clock Source, 
sélectionnez une source d'horloge. 

3  Cliquez sur OK. 

Configuration de la boîte de 
dialogue I/O Setup

La boîte de dialogue de configuration des E/S 
(I/O Setup) permet de marquer les chemins de 
signaux d'entrée, de sortie, d'insert et de bus de 
Pro Tools LE. Elle fournit une représentation 
graphique de l'assignation des entrées, sorties et 
signaux de Mbox 2.

Pro Tools LE est livré avec les paramètres I/O 
Setup par défaut, qui vous permettent de 
démarrer. Pour renommer les chemins d'E/S, 
utilisez la boîte de dialogue I/O Setup.

Pour que la synchronisation de Pro Tools 
avec le périphérique se réalise avec succès, 
votre périphérique d'entrée numérique doit 
être connecté et sous tension. S'il n'est pas 
sous tension, laissez la valeur Clock Source 
sur Internal.
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Pour renommer les chemins d'E/S dans 
I/O Setup :

1  Sélectionnez Setup > I/O.

2  Pour afficher les connexions Input, Output, 
Insert ou Bus, cliquez sur l'onglet correspondant.

3  Pour modifier le nom d'un chemin ou 
sous-chemin, cliquez deux fois directement sur 
le nom du chemin, tapez le nouveau nom et 
appuyez sur la touche Retour. 

4  Cliquez sur OK.

Boîte de dialogue I/O Setup pour Mbox 2

Pour obtenir des informations sur 
l'attribution de nouveaux noms aux 
chemins d'E/S, reportez-vous au Guide de 
référence Pro Tools ou sélectionnez Help > 
Pro Tools Reference Guide.
Guide Introduction à Mbox 2
Audio MIDI Setup (AMS)

(facultative)

Si vous décidez d'utiliser des périphériques MIDI 
avec Pro Tools LE, configurez votre installation 
MIDI avec l'utilitaire de configuration Audio 
MIDI Setup (AMS) d'Apple. Pour plus 
d'informations, consultez la section Annexe B, 
Configuration d'AMS (Mac OS X uniquement). 

Sauvegarde de la configuration du 
système

Une fois la configuration de Pro Tools et du 
système terminée, enregistrez une image de 
votre disque système à l'aide d'un utilitaire 
de sauvegarde tel que Bombich Carbon Copy 
Cloner. Cette opération vous permet, en cas de 
problèmes, de restaurer rapidement la 
configuration et les paramètres de votre 
système.



Désinstallation de 
Pro Tools LE
Utilisez le CD d'installation ou le fichier 
d'installation téléchargé pour supprimer 
Pro Tools de votre ordinateur. 

Pour supprimer Pro Tools de votre ordinateur :

1  Assurez-vous que vous êtes connecté en 
tant qu'administrateur au compte sur lequel 
Pro Tools est installé. Pour obtenir des détails 
sur les privilèges d'administrateur sur Mac OS X, 
reportez-vous à votre documentation 
Apple OS X. 

2  Insérez le CD-ROM d'installation de Pro Tools 
dans le lecteur de CD-ROM ou accédez au fichier 
d'installation téléchargé. 

3  Cliquez deux fois sur Install Pro Tools LE.

4  Entrez le mot de passe administrateur, puis 
cliquez sur OK. 

5  Dans la fenêtre du programme d'installation, 
choisissez Uninstall dans le menu déroulant et 
cliquez sur Uninstall. 

6  Suivez les instructions à l'écran pour 
supprimer Pro Tools LE.

7  Une fois la procédure terminée, cliquez sur 
Quit pour fermer la fenêtre du programme 
d'installation.
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chapitre 4

Matériel et connexions au système Mbox 2

Ce chapitre présente la méthode de connexion à votre système Mbox 2 à des fins d'écoute, de lecture 
et d'enregistrement. Si vous utilisez des stations de travail audionumériques pour la première fois, 
lisez d'abord le guide Notions de base de Mbox 2 pour obtenir des informations élémentaires de 
configuration (telles que la connexion aux entrées audio, aux haut-parleurs, aux micros et aux 
instruments).
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Les illustrations suivantes présentent deux méthodes de configuration possibles, selon l'équipement 
de votre studio.
Guide Introduction à Mbox 2
Figure 1.  Configuration du micro studio Mbox 2 exécutant Pro Tools LE sur un PC
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Figure 2.  Configuration du micro studio Mbox 2 exécutant Pro Tools LE sur un ordinateur portable
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Caractéristiques du panneau avant de Mbox 2
Le panneau avant de Mbox 2 intègre les éléments suivants :
Guide Introduction à Mbox 2
Figure 3.  Panneau avant de Mbox 2 
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Ce voyant indique que Mbox 2 utilise les 
entrées S/PDIF en tant que source d'horloge. 
Reportez-vous à la section E/S numériques 
S/PDIF, page 40.

Voyant USB

Le voyant USB indique que le système Mbox 2 
est alimenté via la connexion USB. Lorsque 
le voyant USB est allumé, les données audio 
peuvent circuler à l'intérieur ou à l'extérieur 
du système.

Sortie de casque du panneau 
avant

Utilisez la sortie casque pour connecter un 
casque stéréo doté d'un mini-connecteur stéréo 
1/4 de pouce. 
Potentiomètre de niveau 
du casque

Le bouton de niveau du casque permet de 
régler le niveau du port de casque qui émet 
le signal acheminé vers les sorties 1 et 2 dans 
Pro Tools LE et reflète les sorties de ligne. 

Niveau d'écoute

Le bouton d'écoute permet de régler le niveau 
de sortie des ports de sortie de ligne. Dans 
Pro Tools, il s'agit du signal acheminé vers les 
sorties 1 et 2.



Commande Mix (ratio)

Mbox 2 vous offre la possibilité de contrôler les 
signaux d'entrée pendant l'enregistrement, sans 
le retard induit par les convertisseurs A/N/A et le 
traitement effectué sur des applications hôtes.

Le bouton Mix permet de contrôler cette écoute 
à latence zéro, ce qui permet de mélanger et 
de régler le rapport d'écoute entre les entrées 
analogiques Mbox 2 et la lecture Pro Tools. 
Le bouton Mix n'a aucun effet lorsque vous 
utilisez les entrées numériques S/PDIF, étant 
donné qu'il peut contrôler le signal avant 
d'atteindre les convertisseurs A/N.

Pour n'écouter que le signal d'entrée Source, 
tournez le bouton complètement vers la gauche, 
en position Input. Pour n'écouter que le 
signal de sortie Pro Tools, tournez le bouton 
complètement vers la droite, en position 
Playback.

Le signal de sortie provenant de la commande 
Mix est acheminé directement vers les sorties de 
ligne TRS et se répercute au niveau des ports de 
casque et des ports de sortie S/PDIF.

La possibilité de mélanger et de contrôler 
les niveaux relatifs de la lecture Pro Tools 
et les entrées directes sans latence s'avère 
particulièrement utile dans le cas 
d'enregistrements fractionnés (overdubbing). 
Touche et voyant Mono

Le bouton Mono convertit le signal des canaux 
d'entrée en signal mono qu'il transmet vers 
les deux haut-parleurs. Cela n'a aucun effet 
sur l'écoute de la lecture dans Pro Tools, 
l'enregistrement ou sur les sorties principales. 
Il s'avère utile de configurer le signal source 
stéréo en mono, lorsque vous enregistrez une 
entrée mono tout en écoutant une lecture stéréo 
(pour écouter la lecture des deux côtés) ou pour 
vérifier les relations de phase entre les entrées 
stéréo. Le voyant Mono s'allume lorsque cette 
opération est en cours.

Ecoute lors d'opération d'enregistrements 
fractionnés

La possibilité d'appliquer un panoramique 
aux signaux envoyés vers le centre ou d'utiliser 
le bouton Mono (au lieu de les écouter en les 
soumettant à un panoramique jusqu'aux 
extrémités gauche et droite sur les sorties 
casque) facilite la création d'un mixage d'écoute 
de qualité focalisé lors d'enregistrements 
fractionnés. 

Dans le cas où vous devez contrôler 
conjointement des microphones stéréo, des 
synthétiseurs stéréo ou toute autre paire de 
source dotée d'un équilibre confortable, vous 
ne souhaiterez probablement pas utiliser la 
commande Mono. 
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Vérification des relations de phase

Vous pouvez également utiliser le bouton Mono 
pour vérifier brièvement la phase entre le signal 
d'entrée de la source 1 et celui de la source 2.

Lorsque les deux signaux d'entrée sont 
déphasés, le fait d'appuyer sur le bouton 
Mono produit un son « sourd » résultant 
de l'annulation de phase. Ce test rapide effectué 
à l'aide du bouton Mono permet d'éviter des 
problèmes ultérieurs lors du mixage de ces 
pistes. La vérification régulière des relations 
de phase avec le bouton Mono peut également 
vous aider à savoir comment placer le micro de 
façon optimale.

Touche et voyant 48 V

L'alimentation fantôme est activée au moyen 
du commutateur 48 V situé sur le panneau 
avant de Mbox 2. Lorsque ce voyant est allumé, 
il indique que l'alimentation fantôme de 48 V 
est active au niveau des entrées Mic/Line. 
Ces entrées permettent de fournir aux 
microphones l'alimentation fantôme nécessaire 
à leur fonctionnement. 
Guide Introduction à Mbox 2
A propos de l'alimentation fantôme

Les micros dynamiques (les Shure SM57, 
par exemple) ne requièrent pas d'alimentation 
fantôme, mais celle-ci ne les endommage pas. 
La plupart des micros à condensateur 
(par exemple, AKG C3000) requièrent une 
alimentation fantôme pour fonctionner. 

En cas de doute concernant l'alimentation 
fantôme de votre micro, consultez le fabricant 
ou lisez la documentation se rapportant à votre 
micro.

Voyant de crête

Ces voyants sont des indicateurs d'écrêtage. 
Si les voyants de crête clignotent de temps à 
autre, cela signifie que le signal ayant atteint 
Mbox 2 a été écrêté.

L'alimentation fantôme peut être utilisée 
en toute sécurité avec la plupart des micros. 
Cependant, elle peut endommager les 
micros à ruban, Veillez à la désactiver 
et patientez au moins dix secondes avant de 
connecter ou de déconnecter un microphone 
à ruban.



Commandes de gain

Ces boutons permettent de régler les niveaux de 
gain d'entrée des entrées Mic/Line.

Touches et voyants Pad

Les touches Pad permettent de réduire de 
20 dB le niveau du signal délivré sur les canaux 
d'entrée correspondants. Les voyants Pad 
s'allument lorsque cette opération est en cours. 

Voyants et sélecteurs sources

Ces touches permettent de sélectionner 
les entrées Mic ou DI pour chaque canal. 
Les voyants DI et Mic indiquent l'entrée source 
active. Pour plus d'informations, reportez-vous à 
la section Audio analogique, page 42. 
Poignée amovible

Mbox 2 est équipé d'une poignée permettant de 
transporter ou d'orienter l'unité, ainsi que d'un 
panneau de remplacement qui en réduit la taille. 

◆ Une fois Mbox 2 sur le bureau, utilisez la 
poignée comme un socle pour orienter l'unité 
selon un meilleur angle de vision. La poignée 
sert également au transport de l'unité. 

◆ Elle peut être remplacée par un panneau plan, 
qui vous permet de poser Mbox 2 à plat sur le 
bureau et qui réduit le volume de l'unité une fois 
celle-ci emballée pour être transportée. 

Pour remplacer la poignée par le panneau 
Mbox 2 :

1  Dévissez les vis de montage de la poignée 
situées le long de sa bordure droite (vue de face). 

2  Retirez la poignée. 

3  Montez le panneau de remplacement dans la 
même position. 

4  Fixez le panneau à l'unité dans sa nouvelle 
position à l'aide des vis retirées à l'étape 1.

5  Répétez les instructions ci-dessus pour 
remplacer le panneau par la poignée. 
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Caractéristiques du panneau arrière de Mbox 2
La Figure 4 permet d'identifier tous les ports du panneau arrière de l'unité Mbox 2. 
Guide Introduction à Mbox 2
Figure 4.  Panneau arrière de Mbox 2
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Le panneau arrière de Mbox 2 intègre les 
éléments suivants :

Port USB

Le connecteur USB v1.1 standard permet 
de connecter l'ordinateur à l'unité Mbox 2. 
Le système vous est fourni avec un câble USB 
standard. 

Mbox 2 est compatible avec les ports USB 2.0. 
Cependant, le bus USB 2.0 passe à la vitesse 
USB v.1.1 plus lente pour fonctionner avec 
Mbox 2.

E/S MIDI

L'unité est équipée de ports d'entrée et sortie 
MIDI à 5 broches standard, fournissant 
16 canaux d'entrée et sortie MIDI chacun. 
E/S numériques S/PDIF

Les ports d'E/S S/PDIF sont des connecteurs 
asymétriques à 2 conducteurs phono (RCA) 
qui utilisent un flux de données numériques 
de 24 bits, à deux canaux.

Le format d'interface numérique 
Sony/Philips (S/PDIF) est utilisé sur de 
nombreux enregistreurs de CD et enregistreurs 
DAT destinés aux professionnels et au grand 
public. Pour éviter l'interférence RF, utilisez un 
câble coaxial de 75 ohms pour les transferts 
S/PDIF et veillez à ce que la longueur totale de 
câble n'excède pas 10 mètres. 

Dans la pratique, les canaux d'entrée S/PDIF 
permettent de compléter les deux canaux 
d'entrée audio analogique. Ainsi, l'unité Mbox 2 
peut être utilisée en tant qu'interface audio 
numérique, dotée de 4 entrées et de 2 sorties, 
du logiciel Pro Tools LE. 

Les canaux de sortie S/PDIF reflètent toujours les 
sorties principales 1 et 2. 



Sortie d'écoute

Ces sorties prennent en charge les connexions 
TRS symétriques ou TS asymétriques 1/4 de 
pouce. Ces sorties peuvent être connectées à une 
console de mixage, directement à un système 
d'écoute tel qu'un amplificateur de puissance 
stéréo ou à toute autre destination stéréo afin 
d'écouter le mixage.

Les sorties d'écoute droite et gauche lisent les 
données audio acheminées respectivement vers 
les sorties analogiques 1 et 2 depuis Pro Tools. 
Ces sorties analogiques sont dotées de 
convertisseurs analogiques-numériques 24 bits.

Entrée 1 et Entrée 2

Les deux canaux d'entrée sources analogiques 
(Entrée 1 et Entrée 2) fournissent des ports 
micro, DI et ligne (TRS). Ces entrées audio 
analogiques symétriques/asymétriques 
prennent en charge une gamme étendue de 
niveaux d'entrée :

• Mic (micro) pour les entrées XLR ;

• Line (TRS) pour les signaux de niveau ligne 
sur des entrées TRS ou TS ;

• Inst (instrument) pour une autre 
connexion TRS ou TS 1/4 de pouce.

Sur le panneau avant, la commande de gain 
des canaux permet d'en régler le signal d'entrée 
et les sélecteurs de source de choisir la source, 
micro/ligne ou DI. 
Source 2 se situe à l'extrémité gauche (lorsque 
vous regardez le panneau arrière) et Source 1 
à droite de Source 2. Les entrées du panneau 
arrière correspondant à Source 1 et 2 sont situées 
parallèlement aux commandes d'entrée qui leur 
sont associées sur le panneau avant. Cela vous 
permet de localiser plus facilement les prises 
d'entrée si vous n'avez pas le panneau arrière en 
face de vous. 

Etablissement de connexions 
de signaux avec Mbox 2
Vous pouvez utiliser Mbox 2 dans diverses 
configurations audio. Cette section décrit 
l'établissement de connexions de base pour :

• l'écoute ;

• l'entrée analogique et numérique en 
enregistrement ;

• le MIDI ;

• le mixage final.

Ecoute de l'audio

Pour une écoute avec le casque, connectez ce 
dernier au port 1/4 de pouce du panneau avant. 
Réglez le niveau du casque à l'aide du 
potentiomètre correspondant.

Les sorties d'écoute de Mbox 2 lisent la source 
audio acheminée depuis Pro Tools vers les 
sorties analogiques 1 et 2. Elles peuvent servir de 
sorties gauche et droite vers un magnétophone à 
deux pistes, ou vers une autre destination stéréo, 
pour des mixages finaux. 

Bien que les connecteurs XLR prennent 
en charge les entrées de niveau de micro 
et d'instrument, lorsqu'un câble TRS est 
branché au port Line (TRS), le port XLR 
sur ce canal est ignoré. 
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Les sorties d'écoute de Mbox 2 sont reliées à des 
convertisseurs N/A 24 bits capables de produire 
un signal maximal de +4 dBu/+2 dBV (signal 
symétrique/asymétrique). Les connecteurs sont 
des ports TRS ; les connecteurs TS asymétriques 
sont également pris en charge.

Pour brancher le casque :

• Si votre casque possède un mini-connecteur 
(ou adaptateur) stéréo 1/4 de pouce, 
branchez-le à la prise casque. 

Pour effectuer le branchement sur une chaîne 
stéréo :

■ A l'aide de câbles 1/4 de pouce, connectez les 
sorties d'écoute droite et gauche, situées sur le 
panneau arrière de Mbox 2 aux entrées 
correspondantes sur votre console de stéréo. 

Vous pouvez écouter des données audio 
Pro Tools via des haut-parleurs connectés 
à votre ordinateur. Pour écouter des 
données audio, connectez un casque, des 
haut-parleurs ou un amplificateur externe 
sur votre Mbox 2.

La sortie casque Mbox 2 peut produire des 
niveaux de sortie très élevés. Une écoute 
prolongée peut provoquer des problèmes 
d'audition. Prenez le temps de régler le 
volume du casque à l'aide du potentiomètre 
correspondant situé sur le panneau avant.

Les chaînes stéréo utilisent souvent des 
connecteurs RCA. Vous pouvez utiliser 
un adaptateur ou un câble spécial pour 
convertir les connecteurs TRS ou TS de 
Mbox 2 en connecteurs RCA utilisables 
avec votre stéréo.
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Pour brancher des haut-parleurs avec un 
amplificateur de puissance ou des haut-parleurs 
d'écoute auto-alimentés :

■ A l'aide de câbles 1/4 de pouce, connectez 
les sorties d'écoute droite et gauche, situées sur 
le panneau arrière de Mbox 2, aux entrées 
correspondantes sur votre console de mixage, 
votre amplificateur de puissance ou vos haut-
parleurs. 

Connexion de sources audio à 
Mbox 2 pour l'enregistrement

Il est possible de connecter directement des 
sources numériques et analogiques à Mbox 2.

Audio analogique

Les signaux analogiques sont produits par 
des microphones, synthétiseurs, consoles de 
mixage et instruments dotés de bobines 
magnétiques. Parmi ces sources, les signaux 
les plus faibles sont générés par les micros et 
instruments à bobines magnétiques et ils 
nécessitent généralement une amplification 
maximale. Les claviers, préamplificateurs et 
consoles de mixage produisent de l'audio de 
« niveau ligne », qui varie d'un équipement à 
l'autre entre les normes –10 dBV et +4 dBu. 

Pour s'adapter à ces différentes sources, Mbox 2 
est doté de niveaux d'entrées qu'il est possible 
d'alterner, avec réglage du gain pour chaque 
canal d'entrée.



Pour connecter une source audio analogique :

1  Effectuez l'une des opérations suivantes :

• Pour connecter un micro, branchez un 
câble XLR directement à l'entrée micro 
Input 1 ou Input 2. 

• Pour connecter un clavier, une console 
ou une source TRS 1/4 de pouce, branchez 
son ou ses câbles TRS directement aux ports 
de ligne (TRS) Input 1 et/ou Input 2. 
Assurez-vous de ne rien brancher à l'entrée 
Mic du canal. 

• Pour connecter une guitare, une basse ou 
un instrument similaire, branchez son 
câble TS au port DI Input 1 ou Input 2. 

2  Sur le panneau avant, appuyez sur la touche 
de sélection de source du canal requise :

• Pour sélectionner l'entrée du micro (XLR), 
appuyez sur la touche source du canal en 
question jusqu'à ce que le voyant Mic 
s'allume. Assurez-vous de n'avoir rien 
branché au port Line (TRS) du canal. 

• Pour sélectionner l'entrée de ligne (TRS), 
appuyez sur la touche source du canal en 
question jusqu'à ce que le voyant Mic 
s'allume. 

• Pour sélectionner le port ID, appuyez sur la 
touche source du canal en question jusqu'à 
ce que le voyant DI s'allume. 

Pour activer l'alimentation fantôme :

■ Si votre micro nécessite une alimentation 
fantôme, assurez-vous tout d'abord qu'il est 
connecté, puis appuyez sur le bouton 
correspondant à l'alimentation fantôme (48 V).

L'activation de l'alimentation fantôme fait 
circuler 48 V sur les deux entrées 
microphone. 
Audio numérique

Mbox 2 comporte des entrées et sorties 
numériques au format S/PDIF. Vous pouvez 
utiliser les deux canaux d'entrée numérique 
S/PDIF conjointement avec les deux entrées 
analogiques de façon à disposer simultanément 
de quatre canaux d'entrée. 

A propos de S/PDIF

L'E/S S/PDIF (Sony/Philips Digital Interchange 
Format) est disponible sur la plupart des 
appareils DAT, enregistreurs de CD et autres 
dispositifs numériques. Chaque connexion 
S/PDIF fournit 2 canaux d'audio numériques 
de 24 bits. 

Pour connecter un périphérique S/PDIF sur 
Mbox 2 :

1  Utilisez deux câbles coaxiaux de 75 ohms 
équipés de connecteurs mâles RCA à chacune de 
leurs extrémités (achetés séparément). 

2  Connectez la sortie S/PDIF du périphérique 
au port d'entrée S/PDIF sur Mbox 2 et l'entrée 
S/PDIF du périphérique au port de sortie S/PDIF 
sur Mbox 2.

Pour configurer Mbox 2 pour l'enregistrement 
depuis une source numérique, sélectionnez 
Setups > Hardware Setup dans Pro Tools, puis 
sélectionnez S/PDIF dans le sélecteur de la 
source d'horloge. 
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Pour configurer Pro Tools pour l'enregistrement 
depuis un périphérique S/PDIF :

1  Choisissez Setups > Hardware Setup. 

2  Sélectionnez S/PDIF dans le sélecteur de 
la source d'horloge. Sur le panneau avant, 
le voyant S/PDIF s'allume. 

3  A l'aide du sélecteur d'entrée de la piste 
d'enregistrement, sélectionnez la source S/PDIF 
mono ou stéréo requise. 

Duplication des sorties en S/PDIF

Pro Tools LE utilise la mise en miroir des sorties 
S/PDIF pour « dupliquer » automatiquement 
l'audio envoyé vers les sorties de ligne 1 et 2 
sur les sorties RCA S/PDIF. Cela est utile si vous 
écoutez un mixage à l'aide de vos sorties de ligne 
et que vous l'enregistrez en même temps sur un 
dispositif S/PDIF externe.

Connexions MIDI

Les deux ports MIDI de Mbox 2 vous 
permettent de tirer parti de toutes les fonctions 
MIDI de Pro Tools LE, y compris les fonctions 
d'enregistrement et de modification de pistes 
MIDI.

L'ajout d'une interface MIDI compatible 
vous permet de disposer de ports MIDI 
supplémentaires. Les interfaces MIDI USB 
fonctionnent correctement avec les systèmes 
Pro Tools sous Windows et Macintosh. 

Pour plus d'informations sur les concepts de 
base MIDI, reportez-vous au guide Notions 
de base de Mbox 2.
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Les interfaces série MIDI sont prises en charge 
sur les systèmes Windows uniquement.

Pour connecter des périphériques MIDI à votre 
système :

1  Connectez la sortie MIDI de votre 
périphérique ou contrôleur MIDI au port 
d'entrée MIDI du panneau arrière de Mbox 2.

2  Connectez l'entrée MIDI de votre 
périphérique ou contrôleur MIDI au port de 
sortie MIDI du panneau arrière de Mbox 2.

Seules les interfaces MIDI USB sont 
compatibles avec les systèmes Pro Tools 
pour Mac OS X. Les adaptateurs de port 
modem-série et les périphériques MIDI série 
ne sont pas pris en charge.

Si vous souhaitez obtenir plus 
d'informations sur la configuration d'un 
studio MIDI pour une utilisation avec 
Pro Tools, reportez-vous à l'Annexe A, 
Configuration de MIDI Studio Setup 
(Windows uniquement) ou à l'Annexe B, 
Configuration d'AMS (Mac OS X 
uniquement). 

Les informations MIDI ne sont pas des sons. 
Pour écouter la sortie de vos périphériques 
MIDI au sein de votre système Pro Tools, 
vous devez acheminer la sortie audio de votre 
périphérique MIDI vers les entrées audio du 
système Mbox 2 et écouter ou enregistrer les 
données audio dans votre session. Pour plus 
d'informations, reportez-vous à la section 
Etablissement de connexions de signaux avec 
Mbox 2, page 41.



Connexion d'un appareil 
analogique pour le mixage final

Après l'enregistrement et le mixage des 
sessions dans Pro Tools, vous pouvez effectuer 
un mixage final vers un lecteur DAT, un 
enregistreur de CD, un lecteur de mini-disques 
ou tout autre périphérique d'enregistrement 
stéréo à deux pistes. 

Connexion d'un appareil analogique

Connectez les sorties d'écoute droite et gauche 
situées à l'arrière du système Mbox 2 aux entrées 
analogiques de votre enregistreur. Acheminez 
le signal des sorties d'écoute droite et gauche 
vers les entrées droite et gauche respectives de 
l'enregistreur. Ces sorties sont des ports TRS. 
Vous aurez besoin de câbles d'adaptateurs si votre 
appareil de mixage final possède des entrées RCA.

Connexion d'un appareil numérique

Si vous possédez un enregistreur de CD, un 
lecteur DAT ou tout autre périphérique recevant 
un signal S/PDIF, connectez-le aux ports RCA 
d'entrée et de sortie S/PDIF situés à l'arrière de 
Mbox 2.

Pour plus d'informations sur les options de 
mixage, consultez le Chapitre 5, Utilisation 
de Pro Tools LE.

Lors de l'enregistrement depuis Pro Tools 
vers un périphérique numérique, assurez-
vous que la source d'horloge Pro Tools est 
définie sur le mode Internal.
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chapitre 5

Utilisation de Pro Tools LE
Ce didacticiel présente les principales fenêtres 
et fonctions de Pro Tools LE, ainsi que la 
procédure d'enregistrement audio de base. 

Toutes les fonctions décrites dans ce chapitre 
sont expliquées en détails dans le Guide de 
référence Pro Tools.

Vous pouvez afficher le Guide de référence au 
format PDF en le sélectionnant dans le menu 
d'aide de Pro Tools. 

Notions de base sur les 
sessions
Les projets Pro Tools LE sont créés et enregistrés 
sous forme de sessions. Celles-ci contiennent 
toutes les données audio, MIDI et autres 
informations relatives à la session. Les fichiers 
audio, de fondu, de groupe de régions et de 
sauvegarde de session sont enregistrés dans les 
sous-dossiers du dossier de la session.

Dossier de la session, comprenant le fichier de la 
session et ses dossiers associés
Lancement d'une session

Pour créer une session :

1  Lancez Pro Tools LE.

2  Sélectionnez File > New Session. 

3  Dans la boîte de dialogue New Session, 
définissez le type de fichier audio, la fréquence 
d'échantillonnage et la résolution correspondant 
à la nouvelle session.

4  Sélectionnez l'emplacement où vous souhaitez 
enregistrer la session. Si vous utilisez des disques 
durs externes avec le système Pro Tools, veillez 
à sélectionner le disque approprié dans la boîte 
de dialogue New Session.

5  Attribuez un nom à la session.

6  Cliquez sur Save. Les fenêtres Mix, Edit et 
Transport de la nouvelle session s'affichent.

Boîte de dialogue New Session
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Fenêtres principales

Les fenêtres Mix, Edit et Transport constituent 
l'espace de travail principal de Pro Tools. Vous 
pouvez afficher ces fenêtres en les sélectionnant 
dans le menu Window. 

Fenêtre Edit : affiche les pistes de la session le 
long de la timeline pour l'édition de données 
audio, MIDI et d'automation. 
Guide Introduction à Mbox 2
Fenêtre Mix : affiche la console de mixage 
Pro Tools et ses commandes de fader standard 
pour le volume, le panoramique, la mise en solo, 
la coupure de son et l'acheminement du signal.

Pour basculer de la fenêtre Edit à la 
fenêtre Mix, et inversement, appuyez 
sur la combinaison de touches Pomme 
+ touche égal (=) (Macintosh) ou Ctrl 
+ touche égal (=) (Windows).
Figure 5.  Fenêtre Edit
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Fenêtre Transport : affiche les commandes de lecture, d'arrêt, d'avance et de retour rapide, de pause et 
d'enregistrement. Cette fenêtre peut également inclure les affichages Counter et MIDI Control.

Figure 6.  Fenêtre Mix

Pistes

Inserts

Départs

Commandes des pistes

Curseurs de panoramique

Fader de volume Vumètre de niveau

Insert plug-in

Commandes de départ
Figure 7.  Fenêtre Transport
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Commandes MIDI
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Règles

Pro Tools LE fournit différentes graduations, 
ou règles, vous permettant de naviguer dans 
votre session. 

Règles temporelles

Les règles temporelles, affichées en haut de la 
fenêtre Edit, incluent Bars:Beats, Minutes:Seconds 
et Samples. La règle temporelle utilisée détermine 
le format du compteur principal et fournit la base 
de la grille de la fenêtre Edit. 

Pour sélectionner une règle temporelle :

■ Cliquez sur le nom de la règle en haut à 
gauche de la fenêtre Edit.

Règles de chef d'orchestre

Les règles de chef d'orchestre qui s'affichent 
en dessous des règles temporelles incluent 
Tempo, Meter et Markers. Les règles Meter et 
Tempo indiquent les modifications apportées 
aux données de tempo et de mesure dans la 
session. La règle Markers affiche des marqueurs 
aux emplacements importants de la piste. 

Sélection d'une règle temporelle
Guide Introduction à Mbox 2
Définition du tempo

Vous pouvez définir le tempo de la session à 
l'aide du marqueur de début de morceau situé 
sur la règle de tempo.

Pour régler le tempo d'une session à l'aide du 
marqueur de début de morceau :

1  Dans la règle de tempo, cliquez deux fois sur le 
marqueur de début de morceau.

2  Dans la boîte de dialogue Tempo Change, 
entrez la valeur de tempo en BPM (beats per 
minute) pour la session. La valeur de tempo 
ainsi spécifiée remplace celle par défaut pour 
la session.

3  Pour baser la valeur BPM sur une valeur de note 
autre que la double croche par défaut, une triple 
croche par exemple, sélectionnez une valeur de 
note dans le menu contextuel Resolution.

4  Cliquez sur OK.

Marqueur de début de morceau

Boîte de dialogue Change Tempo

Marqueur
de début
de morceau



Utilisation du plug-in Click

Le plug-in Click crée un clic audio lors de la 
lecture de la session. Il fonctionne comme un 
métronome que vous pouvez utiliser comme 
référence de tempo lorsque vous jouez d'un 
instrument ou que vous enregistrez des données 
audio. 

Il est synchronisé aux données de tempo et 
de mesure de la session de Pro Tools et permet 
de suivre toute modification effectuée dans le 
tempo et la mesure.

Paramètres du plug-in Click

Voyant MIDI In : s'allume chaque fois que 
le plug-in Click reçoit un message de clic en 
provenance de l'application Pro Tools, indiquant 
le tempo.

Accented : permet de contrôler le niveau de 
sortie du temps accentué (temps 1 de chaque 
barre) du clic audio.

Unaccented : permet de contrôler le niveau de 
sortie des temps non accentués du clic audio.

Le plug-in Click est l'un des nombreux 
plug-in pouvant être insérés sur une piste 
de Pro Tools. Pour plus d'informations, 
reportez-vous à la section Plug-In, page 77.

Plug-in Click
Pour utiliser le plug-in Click :

1  Sélectionnez Options > Click pour activer 
l'option Click.

– ou –

Cliquez sur le métronome dans la fenêtre 
Transport.

2  Créez une piste d'entrée auxiliaire mono 
(Aux Input).

3  Insérez un plug-in Click sur la piste d'entrée 
auxiliaire. 

4  Dans la fenêtre du plug-in Click, sélectionnez 
un son de clic dans le menu contextuel 
Librarian (ce menu affiche les paramètres par 
défaut lorsque vous insérez le plug-in pour la 
première fois).

5  Sélectionnez Setup > Click, puis définissez les 
paramètres des options Click et Countoff. 

Boutons de commande de la fenêtre Transport

Sélectionnez un son de clic.

Les options Note, Velocity, Duration et 
Output de cette boîte de dialogue doivent 
être utilisées avec des clics sur instruments 
MIDI et n'affectent pas le plug-in Click.

Bouton du métronome
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6  Cliquez sur OK.

7  Lancez la lecture. Un clic audio est généré en 
fonction du tempo et de la mesure de la session 
actuelle, ainsi que des paramètres définis dans la 
boîte de dialogue Click/Countoff.

Utilisation d'un plug-in MIDI Click 
externe

Pro Tools offre également la possibilité d'utiliser 
un périphérique MIDI externe pour émettre 
un clic audio. Cette fonction peut être activée 
ou désactivée à partir de la fenêtre Transport 
et est configurée depuis la boîte de dialogue 
Click/Countoff. 

Pour configurer et activer un clic MIDI externe :

1  Sélectionnez Setup > Click.

Boîte de dialogue Click/Countoff
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2  Configurez les paramètres de clic en fonction 
des besoins de la source audio MIDI.

3  Sélectionnez une source audio MIDI dans la 
liste déroulante Output, puis cliquez sur OK.

4  Vous pouvez activer ou désactiver le clic 
pendant l'enregistrement ou la lecture à l'aide 
du bouton du métronome, situé au niveau des 
commandes MIDI dans la fenêtre Transport. 

Enregistrement de sessions

Vous souhaiterez probablement enregistrer 
votre travail au fur et à mesure de la création 
d'une session (ajout de pistes et modification 
des paramètres par exemple). Pro Tools propose 
trois méthodes d'enregistrement. 

Pour enregistrer une session :

■ Sélectionnez File > Save, File > Save As ou 
File > Save Copy In.

Save : permet d'enregistrer la session ouverte 
sans la fermer. 

Pour plus d'informations sur l'identification 
de périphériques MIDI externes connectés 
au matériel et la configuration du studio 
MIDI dans le cadre d'une utilisation avec 
Pro Tools, reportez-vous à l'Annexe A, 
Configuration de MIDI Studio Setup 
(Windows uniquement)ou à l'Annexe B, 
Configuration d'AMS (Mac OS X 
uniquement).

Boutons de commande de la fenêtre Transport

Bouton du métronome



Save As : crée une copie du fichier de session 
auquel vous pouvez attribuer le nom de votre 
choix, sans le refermer, afin de poursuivre 
l'utilisation. Cela peut s'avérer utile si vous 
souhaitez tester différents arrangements en 
cours de session sans modifier la session 
originale.

Save Copy In : enregistre une copie du fichier 
de session et permet d'enregistrer l'ensemble 
des copies des fichiers audio utilisés pour la 
session en cours. Cela peut s'avérer utile pour 
l'archivage des sessions, la préparation d'une 
session en vue de son transfert vers un autre 
système, l'enregistrement dans un ancien 
format de session Pro Tools ou l'enregistrement 
d'une session à une fréquence d'échantillonnage 
différente.

Ressources et paramètres 
système

Vous pouvez modifier des paramètres système 
spécifiques de Pro Tools pour optimiser les 
performances système.

Boîte de dialogue Playback Engine

La boîte de dialogue Playback Engine permet de 
régler la taille du buffer du système et d'affecter 
davantage de puissance de processeur au système 
Pro Tools. 

Pour configurer les ressources système :

■ Sélectionnez Setup > Playback Engine. 

Pour plus d'informations sur la configuration des 
paramètres système, reportez-vous au chapitre 
sur la configuration de votre plate-forme.
Fenêtre System Usage

La fenêtre System Usage affiche des informations 
approximatives sur la charge du processeur et 
les performances globales du disque, ce qui 
permet d'estimer les capacités de traitement 
de votre système.

Pour afficher les ressources et l'utilisation 
du système :

■ Sélectionnez Window > Show System Usage. 

Boîte de dialogue Playback Engine d'un système 
Pro Tools LE

Vumètres de la fenêtre System Usage
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Commandes de transport
La fenêtre Transport fournit un accès à toutes 
les commandes de transport de Pro Tools LE. 
Il est possible d'afficher ou de masquer certaines 
commandes de transport dans cette fenêtre.

Pour afficher la fenêtre Transport :

■ Sélectionnez Window > Transport. 

Pour configurer la fenêtre Transport :

■ Choisissez View > Transport, puis sélectionnez 
une option de vue disponible. 

La fenêtre Transport comprend les commandes 
les plus utilisées, notamment les boutons Lecture 
et Arrêt.

En affichage étendu, elle contient les indicateurs 
de pré-roll et post-roll, de début, de fin et de 
durée correspondant à la zone sélectionnée dans 
la timeline, ainsi que le sélecteur Transport 
Master. 

Fenêtre Transport (affichage étendu)

Avance rapide

Enregistrement

Fin

LectureArrêt

Retour rapide

Retour à zéro

En ligne
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Vous pouvez également y afficher les 
commandes MIDI suivantes : attente de note, 
métronome, décompte, fusion MIDI, chef 
d'orchestre, Meter et Tempo. 

Pour lancer et arrêter la lecture :

1  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport.

2  Cliquez sur le bouton d'arrêt de la fenêtre 
Transport pour arrêter la lecture.

Fenêtre Transport (commandes MIDI)

Vous pouvez également utiliser la barre 
d'espace de votre clavier pour lancer et 
arrêter la lecture.

Pro Tools LE commence la lecture à 
partir de l'endroit où se trouve le curseur ou 
depuis le début de la sélection en cours. 
Les paramètres en cours des commandes 
Link Edit et Timeline Selection du menu 
Options affectent également la lecture. 
Reportez-vous au Guide de référence 
Pro Tools pour de plus amples informations.

Commandes

Activation de la règle de tempo

Fusion MIDI

Décompte

Métronome

Attente de note

de mesure
et de tempo



Pistes
Pro Tools LE permet de créer des pistes pour 
l'enregistrement, le prémixage, l'acheminement, 
l'automation et l'édition audio et MIDI.

Pro Tools LE propose cinq types de pistes : 
pistes audio, pistes d'entrée auxiliaire, faders 
principaux, pistes MIDI et pistes d'instrument. 
Les pistes audio, les entrées auxiliaires, les faders 
principaux et les pistes d'instrument peuvent 
être mono ou stéréo.

Pistes audio : les pistes audio (Audio Tracks) 
permettent l'enregistrement et la lecture audio 
vers et depuis le disque dur, l'écoute de l'entrée 
audio lorsque l'enregistrement est activé, ainsi 
que la modification de régions audio.

Entrées auxiliaires : canaux de mixage audio 
utilisés pour l'entrée, l'acheminement et le 
prémixage.

Faders principaux : permettent de contrôler les 
canaux principaux et de définir des options de 
chemins de sortie et de bus.

Pistes MIDI : pistes utilisées pour 
l'enregistrement, la lecture et l'édition de 
données MIDI.

Pistes d'instrument : permettent de contrôler les 
plug-in d'instrument ou des périphériques MIDI 
externes dans une seule voie de console grâce 
à leurs fonctions combinées de pistes MIDI et 
d'entrée auxiliaire.
Pour créer une piste :

1  Sélectionnez Track > New. 

2  Indiquez le nombre de pistes, le type de pistes 
et leur nature (mono ou stéréo), pour tous les 
types de pistes, à l'exception des pistes MIDI. 

Pour créer simultanément plusieurs types de 
pistes, cliquez sur le bouton + dans la boîte de 
dialogue New Tracks. Pour chaque piste à créer, 
indiquez le nombre, le type et le format sur 
chaque nouvelle ligne. 

Boîte de dialogue New Track
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3  Cliquez sur Create.

Dans la fenêtre Mix, les pistes audio, les entrées 
auxiliaires, les faders principaux, les pistes MIDI 
et les pistes d'instrument s'affichent sous forme 
de voies verticales. 

Le type de piste est indiqué par les icônes situées 
en dessous des faders et par la couleur des pistes.

Pistes dans la fenêtre Mix

Piste audio Fader principalPiste d'instrument

Piste MIDIPiste d'entrée auxiliaire
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Dans la fenêtre Edit, les pistes sont affichées 
horizontalement le long de la règle temporelle. 
La zone dans laquelle l'audio s'affiche pour 
chaque piste est appelée Playlist. 

Les pistes audio, les entrées auxiliaires, les faders 
principaux, les pistes MIDI et les pistes 
d'instrument peuvent être automatisés. 
Pour plus d'informations, reportez-vous à la 
section Automation du mixage, page 78.

Pistes audio

Les pistes audio, les entrées auxiliaires et 
les faders principaux ont de nombreuses 
commandes en commun. La Figure 8 illustre 
les commandes des pistes audio ou d'entrée 
auxiliaire. Les faders principaux possèdent toutes 
les fonctions des pistes audio ou d'entrée 
auxiliaire, mais diffèrent de la manière suivante : 

Sélecteur d'entrée : l'affectation de sortie 
d'un fader principal détermine son entrée ou 
sa source. 

Règles de la timeline et piste audio dans la fenêtre Edit

Timeline

Playlist



Inserts : les inserts des faders principaux 
constituent des opérations post-fader 
uniquement. En revanche, les inserts de pistes 
audio et d'entrée auxiliaire sont des opérations 
pré-fader.

Départs : les faders principaux ne gèrent pas 
les départs. Par conséquent, si vous souhaitez 
modifier la destination de la sortie, vous devez 
utiliser une piste d'entrée auxiliaire.

Figure 8.  Piste audio stéréo dans la fenêtre Mix
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Pistes MIDI

Outre des commandes d'entrée, de sortie, de 
canal et de programme (patch) MIDI, les pistes 
MIDI possèdent des fonctions de volume, de 
mise en solo et de coupure de son. La Figure 9 
illustre les commandes des pistes MIDI. 

Pistes d'instrument :

Les pistes audio et les pistes d'instrument 
ont de nombreuses commandes en commun. 
Ces dernières disposent néanmoins d'une 
vue supplémentaire, la vue Instruments, 
qui contient les commandes MIDI d'entrée 
et de sortie, de coupure de son, de volume 
et de panoramique. La Figure 10 illustre les 
commandes des pistes d'instrument. 

Figure 9.  Piste MIDI dans la fenêtre Mix
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Figure 10.  Piste d'instrument stéréo dans la fenêtre Mix
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Liste des régions
Une région est un élément de données audio ou 
MIDI auquel peuvent être associées des données 
d'automation. Il peut s'agir par exemple d'une 
boucle, d'un riff de guitare, d'un couplet d'une 
chanson, d'un effet sonore, d'un passage d'un 
dialogue ou d'un fichier audio dans sa totalité. 

Dans Pro Tools, les régions sont créées à partir 
de fichiers audio ou MIDI et peuvent être 
organisées en playlists de pistes audio, MIDI et 
d'instrument.

Toutes les régions enregistrées, importées ou 
créées lors de l'édition apparaissent dans la liste 
des régions. Les régions peuvent être déplacées 
d'une liste vers des pistes et disposées dans 
n'importe quel ordre. Elles peuvent également 
être écoutées à partir de la liste des régions. 
Pour ce faire, cliquez sur une région dans la liste, 
tout en maintenant la touche Option 
(Macintosh) ou Alt (Windows) enfoncée. 
Cette liste déroulante permet de gérer les 
régions et certains fichiers, par le biais de 
fonctionnalités telles que le tri, la sélection de 
régions, l'importation et l'exportation de 
fichiers.

Liste des régions

Faites glisser la bordure 
pour redimensionner la 
largeur de la liste des 
régions.

Pour afficher la liste 
des régions, cliquez 
sur Regions.

Cliquez pour masquer la liste des régions.



Mode d'accès à un 
emplacement à l'intérieur 
d'une session
Pro Tools LE fournit plusieurs façons d'accéder 
à un endroit précis à l'intérieur d'une session, 
notamment à l'aide de la souris ou par saisie d'un 
emplacement mémoire dans l'un des compteurs.

Pour accéder à un emplacement précis depuis la 
fenêtre Edit :

1  Dans le menu Options, vérifiez que les options 
Link Timeline et Edit Selection sont activées.

2  Activez le sélecteur situé en haut de la fenêtre 
Edit en cliquant dessus.

Pour plus d'informations sur la liste des 
régions, consultez le Guide de référence 
Pro Tools.

Outils d'édition de la fenêtre Edit

Sélecteur
3  Cliquez sur une piste ou sur une règle 
temporelle. Le curseur s'affiche à l'emplacement 
sélectionné et les compteurs indiquent le 
timecode correspondant.

Pour accéder à un emplacement concret à l'aide 
des compteurs :

1  Cliquez dans le compteur principal et saisissez 
l'emplacement de votre choix à l'aide du clavier 
de l'ordinateur. 

2  Appuyez sur la touche Entrée (Windows) ou 
Retour (Macintosh). 

Navigation à l'aide du sélecteur dans la fenêtre Edit

Navigation à l'aide du compteur

Vous pouvez également appuyer sur la 
touche astérisque (*) du pavé numérique au 
lieu de cliquer sur le compteur. Le curseur 
s'affiche toujours dans le compteur 
principal de la fenêtre Transport si ce 
dernier est à l'écran. 

Cliquez sur une piste ou une règle temporelle.
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Emplacements mémoire

Les emplacements mémoire et les marqueurs 
constituent une autre méthode de navigation 
dans les sessions. Ils s'affichent comme des 
marqueurs sous les règles temporelles. 
Vous pouvez stocker jusqu'à 999 emplacements 
mémoire ou marqueurs dans une session.

Pour définir un emplacement mémoire :

1  Recherchez l'emplacement dans lequel vous 
souhaitez stocker un marqueur ou emplacement 
mémoire.

– ou –

Lancez la lecture avant le point où vous 
souhaitez stocker un emplacement mémoire ou 
un marqueur. 

2  Pour créer un emplacement mémoire :

• Appuyez sur Entrée sur le pavé numérique.

– ou –

• Cliquez sur le bouton d'ajout 
d'emplacement mémoire/de marqueur (+) 
situé à gauche de la règle des marqueurs. 

Dans la boîte de dialogue New Memory 
Location, vous pouvez définir un marqueur, 
stocker une sélection ou tout autre paramètre 
disponible. Ces paramètres incluent la hauteur 
de pistes, l'activation de groupe, les valeurs de 
pré-roll et de post-roll, ainsi que l'affichage et 
le masquage des pistes. 

Sur certains ordinateurs portables 
Windows, vous pouvez appuyer sur 
Fn+Entrée pour créer un emplacement 
mémoire, ce qui s'avère particulièrement 
utile lorsque l'ordinateur n'offre pas de pavé 
numérique.
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3  Définissez les paramètres de l'emplacement 
mémoire et cliquez sur OK.

Pour accéder à un emplacement de mémoire 
enregistré : 

1  Sélectionnez Window > Memory Locations.

2  Dans la fenêtre Memory Locations, cliquez sur 
le nom de l'emplacement mémoire.

Boîte de dialogue New Memory Location

Fenêtre Memory Locations



Affichage et zoom

Lorsque vous affichez des pistes dans la fenêtre 
Edit, vous pouvez non seulement régler la 
hauteur des pistes, mais également réaliser des 
zooms verticaux et horizontaux à l'aide du 
sélecteur de hauteur de piste et du zoom.

Pour modifier la hauteur de piste :

■ Cliquez sur le sélecteur de hauteur de piste 
(barre verticale graduée, à gauche de la piste) et 
sélectionnez une hauteur de piste dans le menu 
contextuel.

Zoom et sélecteur de hauteur de piste de la fenêtre Edit

De nombreuses commandes, telles que la 
modification de la hauteur de piste, peuvent 
être appliquées simultanément à plusieurs 
pistes. Pour appliquer une opération à 
toutes les pistes, maintenez la touche 
Option (Macintosh) ou Alt (Windows) 
enfoncée. Pour l'appliquer à toutes les pistes 
sélectionnées, maintenez les touches Maj et 
Option (Macintosh) ou Maj et Alt 
(Windows) enfoncées.

Boutons

Zoom

Boutons de zoom arrière/avant

Sélecteur de hauteur de piste

de présélections
de zoom

Boutons
de changement

de zoom
Pour effectuer un zoom avant ou arrière sur une 
partie de piste dans la fenêtre Edit :

1  Cliquez sur le zoom.

2  Cliquez dessus, ou faites-le glisser, pour 
effectuer un zoom avant horizontal sur une 
piste ou une règle. 

– ou –

Pour effectuer un zoom arrière horizontal sur 
une piste ou une règle, procédez de la même 
manière, en maintenant enfoncée la touche Alt 
(Windows) ou Option (Macintosh).

Pour effectuer un zoom avant ou arrière par 
incréments :

■ Cliquez sur le bouton de Zoom approprié :

• Zoom arrière (Flèche gauche)

• Zoom avant (Flèche droite)

• Boutons Audio ou MIDI pour augmenter 
ou réduire le zoom vertical du type de piste 
correspondant

Pour effectuer un zoom avant ou arrière continu :

1  Sélectionnez le zoom. 

2  Maintenez la touche Ctrl (Macintosh) ou de 
démarrage (Windows) enfoncée, puis faites 
glisser le zoom sur une piste, comme suit :

• Vers le haut, pour un zoom avant vertical

• Vers le bas, pour un zoom arrière vertical

• Vers la droite, pour un zoom avant 
horizontal

• Vers la gauche, pour un zoom arrière 
horizontal
Chapitre 5 : Utilisation de Pro Tools LE 61



62
Changement de zoom

Le bouton de changement de zoom permet 
d'enregistrer l'état d'un zoom et de passer du 
zoom enregistré au zoom actuel, et inversement. 
Lorsque ce bouton est sélectionné, la fenêtre 
Edit affiche le zoom enregistré. Lorsque ce 
bouton est désactivé, la fenêtre Edit rétablit 
l'affichage en fonction du dernier zoom 
effectué.

Pour enregistrer un zoom à l'aide du bouton de 
changement de zoom :

1  Effectuez une sélection d'édition.

2  Cliquez sur le bouton de changement de 
zoom pour le mettre en surbrillance.

3  Définissez les valeurs de la hauteur de piste, du 
zoom vertical, de la vue de piste et de la grille.

4  Procédez aux modifications de votre choix.

5  Pour rétablir le zoom précédent, cliquez de 
nouveau sur le bouton de changement de zoom. 

6  Effectuez une autre sélection d'édition et 
cliquez sur le bouton de changement de zoom 
pour charger le zoom enregistré, puis poursuivez 
l'édition.

Bouton de changement de zoom dans la barre d'outils

Bouton de changement de zoom
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Présélections de zoom

Pro Tools fournit également cinq boutons de 
présélection de zoom. Vous pouvez les utiliser 
pour rétablir immédiatement les niveaux de 
zoom. Pour chacun, vous pouvez définir le 
niveau d'agrandissement ou effectuer ce réglage 
lors de chaque session.

Pour enregistrer une nouvelle présélection de 
zoom :

1  Sélectionnez le zoom pour définir un 
paramètre de zoom.

2  Cliquez sur un bouton de présélection de zoom 
(de 1 à 5) et sélectionnez Save Zoom Preset dans 
le menu contextuel de présélection de zoom. 

Pour charger une présélection de zoom 
enregistrée :

■ Cliquez sur le bouton de présélection de zoom 
de votre choix (de 1 à 5).

Menu contextuel de présélection de zoom



Utilisation des emplacements mémoire 
pour la commande de zoom

La fonction de stockage des emplacements 
mémoire Pro Tools permet de stocker de 
nombreux attributs avec chaque marqueur 
ou emplacement mémoire, notamment les 
paramètres de hauteur de piste et de zoom. 
Pour effectuer des zooms avant et arrière à l'aide 
du pavé numérique, vous pouvez utiliser des 
emplacements mémoire qui ne sont ni des 
marqueurs ni des sélections, mais dont les 
paramètres de hauteur de piste et de zoom 
(ou autres options) sont activés.

Pour plus d'informations sur la création 
d'emplacements mémoire, voir Emplacements 
mémoire, page 60.

Importation de données dans 
les sessions Pro Tools
Pro Tools LE permet d'importer des données 
audio, MIDI, et bien d'autres données de session 
Pro Tools dans votre session en cours. 

Importation de données audio

Pro Tools LE permet d'importer des fichiers 
audio à partir du disque dur ou d'un CD. 
Cela s'avère très utile si vous disposez de fichiers 
audio stockés sur votre disque ou si vous 
travaillez avec des bibliothèques d'échantillons 
contenues sur CD et que vous souhaitez les 
utiliser dans une session.
Pour importer des fichiers ou des régions audio 
depuis le disque :

■ Sélectionnez File > Import > Audio to Track 
pour importer des fichiers et des régions dans de 
nouvelles pistes audio (ils s'afficheront également 
dans la liste des régions). 

– ou –

■ Pour importer ces données dans la liste des 
régions uniquement, sélectionnez File > Import 
> Audio to Region List.

Pour importer une piste d'un CD audio :

1  Insérez le CD source dans le lecteur de 
CD-ROM de l'ordinateur.

2  Sélectionnez Window > Workspace et cliquez 
sur l'icône du CD audio pour afficher ses fichiers.

3  Pour écouter un fichier, cliquez sur le 
haut-parleur dans la colonne Waveform du 
navigateur de l'espace de travail. Appuyez sur 
la barre d'espace pour interrompre la lecture. 

Ecoute d'un fichier audio dans le navigateur de l'espace 
de travail
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4  Effectuez l'une des opérations suivantes :

■ Faites glisser les fichiers du navigateur vers 
la liste de pistes de la fenêtre Edit pour importer 
des fichiers dans de nouvelles pistes audio 
(ils s'afficheront également dans la liste des 
régions).

– ou –

■ Pour importer des fichiers dans la liste des 
régions uniquement, faites glisser les fichiers 
du navigateur vers la liste des régions de la 
fenêtre Edit.

Glisser-déposer d'un fichier audio du navigateur 
de l'espace de travail vers la liste de pistes de la 
fenêtre Edit

Pour plus d'informations sur la recherche, 
l'écoute et l'importation de données audio 
avec DigiBase, reportez-vous au Guide 
DigiBase.
Guide Introduction à Mbox 2
Importation MIDI

Pro Tools permet d'importer des fichiers MIDI 
dans la liste des régions ou directement dans les 
pistes MIDI d'une session. 

Pour importer des fichiers MIDI dans la liste des 
régions :

■ Sélectionnez File > Import > MIDI to 
Region List.

Pour importer des fichiers MIDI dans des pistes :

1  Sélectionnez Window > Workspace et 
recherchez les fichiers MIDI à importer.

2  Faites glisser les fichiers MIDI du navigateur de 
l'espace de travail vers la liste de pistes.

3  Dans la boîte de dialogue Import MIDI 
Settings, sélectionnez l'emplacement de 
l'importation et définissez les paramètres 
des données MIDI que vous importez.

Glisser-déposer d'un fichier MIDI du navigateur 
de l'espace de travail vers la liste de pistes de la 
fenêtre Edit

Boîte de dialogue Import MIDI Settings



Importation de fichiers de 
l'Explorateur Windows dans le 
Finder Macintosh

Pro Tools permet de glisser-déposer des fichiers 
de types audio, MIDI, groupe de régions, REX et 
ACID directement de l'Explorateur Windows ou 
du Finder Macintosh vers la timeline ou la liste 
des régions d'une session Pro Tools. 

Enregistrement de base
Cette section décrit la procédure d'enregistrement 
audio et MIDI dans Pro Tools LE. 

Préparation à l'enregistrement

Pour préparer une piste audio à l'enregistrement :

1  Vérifiez les connexions aux micros et aux 
instruments. Pour plus d'informations sur la 
connexion du micro ou d'instruments à 
Mbox 2, reportez-vous au Chapitre 4, Matériel 
et connexions au système Mbox 2.

2  Sélectionnez Track > New. Indiquez 1 (nombre 
de nouvelles pistes), Mono ou Stereo (format des 
pistes) et Audio Track (type de piste, en fonction 
de votre source audio), puis cliquez sur Create.

Pour plus d'informations sur l'importation 
de données dans les sessions Pro Tools, 
reportez-vous au Guide de référence 
Pro Tools.
3  Dans la fenêtre Mix, cliquez sur le sélecteur de 
chemin d'entrée de la nouvelle piste. 

4  Dans le menu contextuel, sélectionnez 
l'entrée d'interface à enregistrer. Par exemple, 
sélectionnez In 1 si la source audio est 
connectée à la prise d'entrée Input 1 du panneau 
arrière de Mbox 2, et In 1-2 si la source audio 
est une source stéréo et qu'elle est connectée aux 
connecteurs d'entrée Input 1 et Input 2.

Acheminement d'une entrée vers une piste mono

Acheminement d'une entrée vers une piste stéréo

Avec Mbox 2, vous pouvez attribuer des 
pistes aux entrées analogiques 1 et 2 
ainsi qu'aux entrées numériques S/PDIF 3 
et 4 (gauche et droite), et réaliser ainsi des 
enregistrements sur quatre pistes 
simultanément. 

Sélecteur de chemin
d'entrée audio
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Réglage des niveaux d'entrée

Situées sur le panneau avant de Mbox 2, les 
commandes de gain vous permettent de régler 
les niveaux d'entrée. Vous pouvez aussi effectuer 
le réglage du niveau des signaux d'entrée à la 
source.

Lorsque vous envoyez un signal vers Pro Tools, 
vérifiez le niveau d'entrée afin d'optimiser la 
plage dynamique et le rapport signal-bruit du 
fichier enregistré. Si le niveau d'entrée est trop 
faible, vous ne bénéficierez pas pleinement de la 
plage dynamique de votre système Pro Tools. 
Si le niveau d'entrée est trop élevé, le signal sera 
écrêté et provoquera des distorsions dans 
l'enregistrement.

Veillez à définir des niveaux légèrement 
supérieurs à 6 dB (cette valeur s'affiche dans le 
vumètre d'entrée) sans déclencher l'indicateur 
d'écrêtage de l'interface audio.

Pour régler les niveaux d'entrée sur Mbox 2 :

1  Lisez l'instrument ou la source sonore au 
niveau de volume de l'enregistrement. 

2  Les commandes de gain de Mbox 2 
permettent d'augmenter ou de réduire le gain, 
et maximiser ainsi les niveaux du signal sans 
aucun écrêtage.

Les niveaux d'entrée doivent être définis 
afin d'éviter l'écrêtage. L'écrêtage est 
signalé par les voyants de crête du panneau 
avant de Mbox 2 et par un indicateur rouge 
au-dessus de chaque vumètre affiché.
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Pour régler l'équilibre d'écoute sur Mbox 2 :

■ A l'aide de la commande Mix sur le panneau 
avant de Mbox 2, effectuez l'une des opérations 
suivantes : 

• Pour n'écouter que le signal d'entrée, 
tournez le bouton Mix complètement 
vers la gauche, vers Input.

• Pour un mélange égal des signaux de 
lecture et d'entrée, positionnez-le au 
centre. 

Enregistrement d'une piste audio

Pour enregistrer une piste audio :

1  Assignez l'entrée de la piste et définissez ses 
niveaux d'entrée.

2  Cliquez sur le bouton d'enregistrement des 
pistes. 

Activation de l'enregistrement d'une piste dans 
la fenêtre Mix



3  Pour afficher la fenêtre Transport, 
sélectionnez Window > Transport.

4  Cliquez sur le bouton de retour à zéro pour 
lancer l'enregistrement depuis le début de la 
session. Vous pouvez également enregistrer 
une sélection de piste ou enregistrer à partir de 
l'emplacement du curseur dans la fenêtre Edit. 

5  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport pour activer l'enregistrement.

6  Cliquez sur le bouton de lecture ou appuyez 
sur la barre d'espace pour enregistrer sur toutes 
les pistes actives.

7  Enregistrez votre travail.

8  A la fin de l'enregistrement, cliquez sur le 
bouton Stop de la fenêtre Transport ou appuyez 
sur la barre d'espace.

Fenêtre Transport (affichage étendu)

Avance rapide

Enregistrement

FinLecture

Arrêt

Retour rapide

Retour à zéro

En ligne
Pour lire une piste enregistrée :

1  Cliquez de nouveau sur le bouton 
d'enregistrement de la piste pour arrêter le mode 
enregistrement. 

2  Sur le panneau avant de Mbox 2, tournez le 
bouton Mix complètement vers la droite, vers 
Playback.

3  Pour lancer la lecture, cliquez sur le bouton de 
lecture de la fenêtre Transport ou appuyez sur la 
barre d'espace.

4  Pour l'arrêter, cliquez sur le bouton d'arrêt 
dans cette même fenêtre ou appuyez sur la barre 
d'espace.

Enregistrement MIDI

Les pistes d'instrument associent une piste 
MIDI et une entrée auxiliaire dans une seule 
voie de console, permettant ainsi d'obtenir ces 
deux fonctionnalités. Les pistes d'instrument 
permettent l'enregistrement de données MIDI 
et de contrôler l'audio à partir d'instruments 
logiciels et matériels.

Pour créer une piste d'instrument et la préparer à 
l'enregistrement :

1  Sélectionnez Setup > MIDI > Input Devices, 
assurez-vous que votre périphérique d'entrée est 
sélectionné dans la fenêtre MIDI Input Enable, 
puis cliquez sur OK.

2  Sélectionnez Track > New, spécifiez 1 Mono 
Instrument Track, puis cliquez sur Create.

3  Sélectionnez View > Mix Window > 
Instruments pour afficher les commandes MIDI 
au-dessus de la piste d'instrument dans la 
fenêtre Mix.
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4  Cliquez sur le sélecteur d'entrée MIDI de la 
piste et affectez le périphérique et le canal qui 
seront enregistrés, ou conservez le paramétrage 
par défaut (All).

5  En fonction de l'instrument que vous utilisez, 
procédez de la manière suivante :

• Si vous utilisez un plug-in, cliquez sur le 
sélecteur d'insert et insérez le plug-in dans 
la piste d'instrument. La sortie de la piste 
MIDI est automatiquement attribuée au 
plug-in.

Sélecteur d'entrée MIDI d'une piste d'instrument

Pour insérer un plug-in sur une piste d'instrument

Sélecteur d'entrée MIDI
Guide Introduction à Mbox 2
• Si vous utilisez un périphérique MIDI 
externe, cliquez sur le sélecteur de sortie 
MIDI (au-dessus de la piste d'instrument) 
et désignez le périphérique et le canal de 
réception de la sortie MIDI, en fonction du 
périphérique.

Sélecteur de sortie MIDI d'une piste d'instrument

Si votre périphérique MIDI, à présent 
connecté, ne s'affiche pas, vérifiez sa 
configuration sur l'ordinateur ainsi que 
celle des paramètres MIDI. Pour plus 
d'informations, reportez-vous à l'Annexe A, 
Configuration de MIDI Studio Setup 
(Windows uniquement) ou à l'Annexe B, 
Configuration d'AMS (Mac OS X 
uniquement).



6  Si vous le souhaitez, vous pouvez modifier les 
numéros de programme par défaut de la piste. 
Pour cela, cliquez sur le bouton de sélection des 
patchs de la fenêtre Mix et effectuez les sélections 
de programme et de banque nécessaires, puis 
cliquez sur Done. Les numéros de programme par 
défaut sont transmis lors de la lecture de la piste.

7  Si vous utilisez un périphérique MIDI externe 
dont la sortie audio est connectée à une interface 
audio et souhaitez contrôler cette sortie à l'aide 
de Pro Tools, cliquez sur le sélecteur d'entrée de la 
piste d'instrument et sélectionnez l'entrée audio 
requise.

8  Cliquez sur le bouton d'enregistrement de la 
piste afin d'activer l'enregistrement MIDI pour la 
piste d'instrument.

9  Vérifiez que l'option MIDI Thru du menu 
Options est sélectionnée.

Bouton de sélection des patchs d'une piste 
d'instrument

Sélection d'une entrée audio pour une piste 
d'instrument

Bouton de sélection des patchs
10  Jouez quelques notes sur votre contrôleur 
MIDI et observez l'évolution du vumètre de 
vitesse MIDI de la piste. Gardez à l'esprit que 
MIDI n'est pas de l'audio et que le vumètre 
de vitesse MIDI n'enregistre pas du son mais 
l'activité MIDI.

11  Réglez le niveau de la sortie audio de la piste 
d'instrument à l'aide du fader de volume.

Pour enregistrer une source MIDI sur la piste 
d'instrument :

1  Vérifiez que l'enregistrement est activé pour la 
piste d'instrument à enregistrer et que celle-ci 
reçoit les données MIDI.

2  Dans la fenêtre Transport, cliquez sur le bouton 
de retour à zéro pour lancer l'enregistrement 
depuis le début de la session. Vous pouvez 
également enregistrer une sélection de piste ou 
enregistrer à partir de l'emplacement du curseur 
dans la fenêtre Edit.

3  Cliquez sur le bouton d'enregistrement de la 
fenêtre Transport.

Vumètre MIDI de piste d'instrument indiquant 
l'activité MIDI

Vumètre de vitesse MIDI
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4  Effectuez l'une des opérations suivantes : 

• Pour lancer l'enregistrement, cliquez sur le 
bouton de lecture dans la fenêtre Transport 
ou appuyez sur la barre d'espace.

• Les boutons de lecture, d'enregistrement et 
d'attente de note clignotent si vous utilisez 
l'option d'attente de note. L'enregistrement 
commence dès la réception du premier 
événement MIDI.

• Si vous utilisez l'option de décompte, 
cliquez sur le bouton de lecture. Les boutons 
d'enregistrement et de lecture clignotent 
pendant le décompte, puis l'enregistrement 
commence.

5  Jouez quelques notes sur le contrôleur MIDI 
ou sur votre périphérique d'entrée.

6  A la fin de l'enregistrement, cliquez sur le 
bouton d'arrêt de la fenêtre Transport ou appuyez 
sur la barre d'espace. Les nouvelles données MIDI 
enregistrées s'affichent sous forme de région 
MIDI au niveau de la piste, dans la fenêtre Edit 
et dans la liste des régions.

Pour lire les données MIDI enregistrées :

1  Cliquez sur le bouton d'enregistrement afin 
de désactiver le mode d'enregistrement pour la 
piste d'instrument.

2  Pour activer la lecture depuis le début de la 
piste, cliquez sur le bouton de retour à zéro dans 
la fenêtre Transport.

3  Pour commencer la lecture, cliquez sur le 
bouton de lecture de la fenêtre Transport. 
Les données MIDI enregistrées sont lues sur 
l'instrument et le canal affectés à la piste.

Données MIDI de la piste d'instrument
Guide Introduction à Mbox 2
Edition
Pro Tools LE fournit plusieurs outils pour 
l'édition audio et MIDI. Dans la fenêtre Edit, 
les pistes audio et MIDI peuvent être éditées 
en régions ou répétées à des emplacements 
différents. Cela permet de créer des boucles, de 
réarranger des sections ou des morceaux entiers 
ou encore d'assembler des pistes en utilisant des 
éléments provenant de plusieurs prises. 

L'édition audio ou MIDI est généralement 
utilisée pour les opérations suivantes :

• Correction ou remplacement d'erreurs

• Réarrangement de chansons et de projets

• Nettoyage du rythme et de la 
synchronisation de piste par alignement 
des sons avec des valeurs Grid, telles que les 
mesures et les temps ou les ambiances

• Création de pistes finales à l'aide de 
sélections provenant de plusieurs prises 
(également appelées comp tracks)

Modes et outils d'édition

Modes d'édition Outils d'édition



Modes d'édition

Pro Tools LE dispose des modes d'édition 
suivants : Shuffle, Spot, Slip et deux modes 
Grid : Absolute (mode Grid Pro Tools standard) 
et Relative.

Pour sélectionner le mode d'édition, cliquez 
sur le bouton correspondant dans la partie 
supérieure gauche de la fenêtre Edit.

Le mode d'édition a une incidence sur le 
déplacement et le positionnement des régions 
audio et MIDI (et des notes MIDI individuelles), 
sur le fonctionnement des commandes Copier 
et Coller, ainsi que sur le fonctionnement des 
différents outils d'édition (outil de trimming, 
sélecteur, main et crayon).

Modes d'édition, boutons

Appuyez sur les touches F1, F2, F3 et F4 
pour définir le mode d'édition Shuffle, Slip, 
Spot et Grid respectivement.

Pour obtenir des informations détaillées sur 
les modes d'édition, reportez-vous au Guide 
de référence Pro Tools.
Outils d'édition

Pro Tools LE offre sept outils d'édition : zoom, 
outil de trimming, sélecteur, main, outil de 
scrubbing, crayon et outil Smart. Sélectionnez 
l'outil de votre choix en cliquant dessus dans 
la fenêtre Edit. Le zoom ainsi que les outils de 
trimming, main et crayon comportent des 
modes différents, qui peuvent être sélectionnés 
depuis un menu contextuel multiple lorsque 
vous cliquez sur l'outil.

Outils d'édition de la fenêtre Edit

Appuyez sur la touche Echap pour basculer 
d'un outil d'édition à l'autre.

Pour obtenir une description détaillée des 
outils d'édition, reportez-vous au Guide de 
référence Pro Tools.

Outil de trimming Main

Outil de scrubbing

CrayonOutil SmartZoom

Sélecteur
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Playlists et édition non destructive

Les playlists permettent de créer et d'extraire 
plusieurs versions du contenu des pistes. Elles 
peuvent comprendre des prises complètes, des 
enregistrements fractionnés ou des ensembles 
de sélections provenant de prises multiples. 
Vous pouvez les dupliquer afin d'enregistrer 
des modifications dans leur état actuel, puis 
poursuivre l'édition de la nouvelle playlist, tout 
en sachant que vous pourrez toujours revenir à 
la version précédente. 

Pour créer plusieurs playlists pour l'édition :

1  Commencez avec une piste sur laquelle vous 
souhaitez apporter différentes modifications.

2  Dans le menu déroulant du sélecteur de 
playlist, choisissez Duplicate.

3  Attribuez un nom à la playlist dupliquée et 
cliquez sur OK.

4  Effectuez vos premières modifications.

5  Retournez à la playlist d'origine en 
sélectionnant son nom dans le menu contextuel 
du sélecteur de playlist.

6  Répétez les étapes 2 à 5 pour effectuer d'autres 
modifications.

Vous pouvez ainsi essayer différents modes 
d'édition de piste et passer d'une playlist à l'autre 
afin de comparer les résultats obtenus.

Sélecteur de playlist et menu contextuel

Sélecteur de playlist
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Edition des régions

Les outils d'édition dans Pro Tools LE 
permettent de modifier des régions dans la 
fenêtre Edit. 

Rognage de régions

Une fois enregistrée, une piste audio contient 
une « région audio ». Si le début de la région 
comporte des silences ou si la fin de région 
inclut de l'audio supplémentaire, vous pouvez 
utiliser l'outil de trimming en mode Slip pour 
raccourcir le début ou la fin de la région.

Pour rogner une région audio :

1  Sélectionnez le mode Slip.

2  Sélectionnez l'outil de trimming.

3  Déplacez le curseur vers le début de la région 
audio (il prend la forme d'un « [ »).

4  Cliquez sur le début de la région et déplacez le 
curseur vers la droite pour raccourcir la région.

Région audio

Région audio sur une piste

Rognage du début d'une région



5  Déplacez le curseur vers la fin de la région 
audio (il prend la forme d'un « ] »).

6  Cliquez sur la fin de la région et déplacez le 
curseur vers la gauche pour raccourcir la région.

L'outil de trimming permet également d'étendre 
une région, lorsque les données audio dépassent 
les limites actuelles de la région. Pour étendre le 
début de la région, faites glisser le curseur vers la 
gauche ; pour en étendre la fin, faites-le glisser 
vers la droite.

Organisation des régions

Il existe plusieurs façons d'éditer et d'organiser 
des régions. L'exemple ci-dessous illustre la 
procédure de création et d'organisation d'une 
boucle de batterie pour composer une piste 
rythmique.

Pour créer et organiser une séquence rythmique :

1  Ouvrez ou créez une session dans 
Pro Tools LE. 

2  Dans la fenêtre Edit, définissez la mesure et le 
tempo de la session en procédant comme suit :

• Cliquez sur le sélecteur de vue de règles et 
sélectionnez Tempo (règles de tempo) et 
Meter (règles de mesure).

• Cliquez sur le bouton d'ajout de tempo et 
spécifiez le tempo.

Rognage de la fin d'une région

Région « rognée »
• Cliquez sur le bouton d'ajout de mesure et 
spécifiez la mesure.

3  Cliquez sur le bouton Grid pour mettre 
Pro Tools en mode Grid.

4  Préparez l'enregistrement à l'aide d'un clic 
(reportez-vous à la section Utilisation du plug-in 
Click, page 51 ou Utilisation d'un plug-in MIDI 
Click externe, page 52). 

5  Enregistrez une piste de batterie (reportez-
vous à la section Enregistrement d'une piste 
audio, page 66) en gardant à l'esprit que vous 
souhaitez n'utiliser que la meilleure mesure 
(votre enregistrement doit pouvoir rentrer dans 
la grille avec le tempo et la mesure spécifiés).

– ou –

Importez un fichier audio, tel qu'une boucle 
de batterie d'une bibliothèque d'échantillons, 
et placez-le sur une piste audio (reportez-vous 
à la section Importation de données audio, 
page 63).

6  Cliquez sur le sélecteur, puis faites glisser la 
forme d'onde pour sélectionner une mesure. 
La sélection s'aligne sur la grille spécifiée.

Boutons d'ajout de tempo et de mesure

Sélection en mode Grid

Ajout de tempo
Ajout de mesure
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7  Créez une piste audio stéréo en sélectionnant 
Track > New. 

8  Cliquez sur la main et sélectionnez l'outil de 
séparation.

9  A l'aide de l'outil de séparation, faites glisser 
la sélection au début de la nouvelle piste audio. 
Une nouvelle région apparaît au début de la 
nouvelle piste.

10  Une fois la région sélectionnée, choisissez 
Region > Loop.

11  Dans la boîte de dialogue Region Looping, 
entrez le nombre de fois que vous souhaitez 
répéter la région et cliquez sur OK.

Vous obtenez alors une nouvelle piste 
rythmique avec une phrase « en boucle » 
(répétée). 

Vous pouvez utiliser ces outils d'édition et Beat 
Detective pour effectuer des opérations d'édition 
plus poussées sur les régions.

Déplacement d'une sélection à l'aide de l'outil de 
séparation

Boîte de dialogue Region Looping
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Regroupement de régions

La fonction Region Groups de Pro Tools permet 
de regrouper des régions sur plusieurs pistes 
audio, MIDI et d'instrument adjacentes. 
Cela s'avère très utile pour la manipulation, 
l'édition et l'organisation des ambiances et 
du tempo.

Mixage
L'environnement de mixage Pro Tools dispose 
de nombreuses commandes de voie standard 
servant au réglage du volume, du panoramique, 
de la mise en solo et de la coupure de son. 
Les commandes de mixage et d'entrée/sortie 
s'affichent dans les fenêtres Mix et Edit.

Pour afficher la fenêtre Mix :

■ Sélectionnez Window > Mix.

Utilisation des commandes de voies

Les pistes audio, d'entrée auxiliaire et 
d'instrument possèdent toutes les commandes 
suivantes :

Fader de volume : permet d'augmenter ou de 
réduire le niveau du volume de la piste en 
faisant glisser son fader de volume vers le haut 
ou vers le bas.

Pour plus d'informations sur les groupes 
de régions, consultez le Guide de référence 
Pro Tools.

Pour basculer de la fenêtre Edit à la fenêtre 
Mix, et inversement, effectuez la 
combinaison de touches Pomme + touche 
égal (=) (Macintosh) ou Ctrl + touche égal 
(=) (Windows).



Curseur de panoramique : permet de régler 
un panoramique dans le mixage. Pour cela, 
déplacez le curseur vers la gauche ou la droite.

Bouton de solo : permet de lire une piste en 
solo (en coupant le son de toutes les autres 
pistes). Pour cela, cliquez sur le bouton de solo 
lui correspondant.

Bouton de coupure du son : permet de couper le 
son d'une piste. Pour cela, cliquez sur le bouton 
Mute correspondant.

Acheminement de base du signal

L'acheminement du signal s'effectue par 
affectation des entrées et des sorties de piste. Les 
entrées de piste audio peuvent provenir de toute 
entrée matérielle ou de tout chemin de bus. 
Une fois enregistrée, l'entrée d'une piste audio 
correspond à son fichier audio sur le disque. 
Les entrées auxiliaires peuvent correspondre à 
n'importe quelle entrée matérielle ou n'importe 
quel chemin de bus interne. Quel que soit le 
type de pistes audio, les sorties peuvent être 
acheminées vers n'importe quelle sortie 
matérielle ou n'importe quel chemin de bus 
interne.

Ces fonctions d'acheminement de signal 
permettent d'adapter virtuellement l'architecture 
de la console de mixage aux projets, notamment 
aux départs et aux retours dans le cadre du 
traitement et du prémixage des effets.
Prémixage de type départ/retour, 
en vue d'un traitement par effets

Lors d'un prémixage pour l'utilisation d'une 
réverbération, d'un délai ou de tout traitement 
d'effets similaire, utilisez les départs et les 
entrées auxiliaires pour recréer le routage de 
départ et de retour d'effets classique. Vous 
pouvez alors utiliser un plug-in temps réel 
(voir la section Plug-In, page 77) en tant que 
ressource partagée pour toutes les pistes incluses 
dans le prémixage. La quantité d'effet (Wet/Dry) 
dans le mixage se dose à l'aide des faders de piste 
(niveau de son direct) et du fader d'entrée 
auxiliaire (niveau de retour d'effet, Wet).

Création d'un départ

Pro Tools LE offre dix départs par piste audio. 
Un départ peut être mono ou stéréo et acheminer 
une sortie ou l'un des 32 chemins de bus internes. 

Pour affecter un départ à une piste :

1  Vérifiez que les départs à utiliser s'affichent 
dans la fenêtre Mix (View > Mix Window > 
Sends A–E ou Sends F–J). 
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2  Dans la fenêtre Mix, cliquez sur le sélecteur de 
départ d'une piste audio et choisissez un chemin 
de bus dans le menu contextuel qui s'affiche.

3  Définissez le niveau de sortie du départ. 
Pour régler sur zéro le niveau d'un départ, il 
suffit de cliquer sur le fader correspondant tout 
en appuyant sur la touche Option (Macintosh) 
ou Alt (Windows). 

Affectation d'un départ à un chemin de bus stéréo

Pour régler le niveau attribué par défaut 
aux nouveaux départs sur –∞ ou sur le 
gain unitaire (0 dB), activez ou 
désactivez l'option Sends Default To 
“–INF” sur la page Operation 
Preferences. 
Guide Introduction à Mbox 2
Création d'un retour

Vous pouvez créer des pistes d'entrée auxiliaire 
pour remplacer les canaux de retour des bus, ainsi 
que des entrées depuis les sources matérielles.

Pour créer un retour :

1  Choisissez Track > New et spécifiez 1 (nombre 
de nouvelles pistes), Mono ou Stereo (format des 
pistes) et Auxiliary Input (type de piste), puis 
cliquez sur Create.

Pistes d'entrées audio et auxiliaires configurées pour 
un départ et un retour

Fenêtre de
Plug-in temps réel

Piste

Piste d'entrée auxiliaire

Pistes audio

auxiliaire
d'entrée
des bus
1-2

départ
Départ vers

bus 1-2



2  Cliquez sur le sélecteur d'entrée de l'entrée 
auxiliaire et réglez-le sur le chemin de bus que 
vous avez affecté aux départs sur les pistes 
source.

3  Cliquez sur le sélecteur de sortie de l'entrée 
auxiliaire et choisissez le chemin de sortie.

Faders principaux

Les faders principaux sont utilisés en tant que 
sortie et bus principaux et peuvent contrôler 
toute sortie mono, stéréo ou multicanal ou le 
chemin de bus dans une session. Vous pouvez 
alors utiliser les commandes du fader principal 
pour contrôler le volume, la mise en solo et la 
coupure de son ou pour appliquer des inserts à 
ces chemins. 

Fader principal contrôlant les chemins de sortie 
principale

Sortie affectée au contrôle
de mixage principal
Pour créer un fader principal :

1  Choisissez Track > New et spécifiez 1 (nombre 
de nouvelles pistes) Mono ou Stereo (format 
des pistes) et Master Fader (type de piste), puis 
cliquez sur Create.

2  Dans la fenêtre Mix, cliquez sur le sélecteur de 
sortie du fader principal et choisissez le chemin 
de sortie que vous souhaitez contrôler. 
Vous pouvez choisir des sorties ou des 
bus internes.

Pour utiliser un fader principal comme contrôle de 
volume stéréo principal pour toutes les pistes 
dans une session :

1  Sélectionnez Track > New et spécifiez 1 Stereo 
Master Fader, puis cliquez sur Create.

2  Envoyez les sorties de toutes les pistes audio 
de la session vers les sorties 1 et 2, puis 
configurez le panoramique de chaque piste.

3  Définissez la sortie du fader principal sur votre 
chemin de sortie principale (sorties 1 et 2).

Plug-In
Les plug-in fournissent des égaliseurs, des 
dynamiques, des retards et d'autres types de 
traitement par effets, et fonctionnent soit en 
temps réel (RTAS), soit en temps non réel 
(AudioSuite).

Les plug-in RTAS correspondent à des effets non 
destructifs, qui s'insèrent sur les pistes pendant 
la lecture pour traiter l'audio en temps réel (de la 
même manière qu'un processeur matériel). 

Les plug-in AudioSuite sont généralement utilisés 
pour traiter et modifier des fichiers audio sur le 
disque. Ils servent moins à la modification en 
temps réel. Selon sa configuration, un plug-in 
AudioSuite non temps réel modifiera le fichier 
source ou créera un fichier audio.
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Les plug-in temps réel sont assignés aux pistes 
depuis l'affichage des inserts dans la fenêtre Mix 
ou Edit. Une fois assignés à une piste, les plug-in 
apparaissent dans la vue Inserts de la piste et 
peuvent être ouverts en cliquant sur le bouton 
d'insertion.

Pour insérer un plug-in temps réel dans une piste :

1  Assurez-vous que la vue Inserts s'affiche dans 
la fenêtre Mix ou Edit.

2  Cliquez sur le sélecteur d'insert sur la piste, 
puis sélectionnez le plug-in à utiliser.

Pro Tools est fourni avec un kit complet de 
plug-in DigiRack et de nombreux plug-in 
supplémentaires sont disponibles auprès de 
Digidesign et de ses partenaires de 
développement. 

Plug-in Compressor

Pour plus d'informations sur les plug-in de 
Pro Tools, consultez le Guide des plug-in 
DigiRack. 

Bouton d'insertion Fenêtre du plug-in
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Automation du mixage
L'automation du mixage permet d'enregistrer 
ou d'automatiser les modifications effectuées 
au niveau du volume d'une piste, des niveaux 
départ, de la coupure de son, du panoramique 
et des paramètres de plug-in.

Pour enregistrer l'automation :

1  Sélectionnez Window > Automation Enable.

2  Dans la fenêtre Automation Enable, activez 
un type d'automation (volume, panoramique, 
coupure de son, niveau de départ, coupure de 
départ ou plug-in) en cliquant sur le bouton 
correspondant. Celui-ci apparaît alors en 
surbrillance.

3  Pour chaque piste à automatiser, 
sélectionnez un mode d'automation (mode 
Write, Touch ou Latch) à l'aide du sélecteur 
de mode d'automation. 

4  Lancez la lecture et démarrez l'enregistrement 
de l'automation en réglant les faders et autres 
boutons en conséquence. Pro Tools LE 
enregistre toutes les modifications apportées 
aux paramètres activés.

Activation de l'automation

Définition du mode d'automation d'une piste



Une fois enregistrée, l'automation peut être 
ré-enregistrée ou affichée et modifiée 
graphiquement dans la fenêtre Edit. 

Mixage final
La commande Bounce to Disk permet d'écrire 
un mixage final sur le disque, de créer une 
boucle, de « figer » des effets ou d'enregistrer 
n'importe quel prémixage. Une fois votre 
prémixage final enregistré, vous pouvez utiliser 
un autre programme pour graver le fichier créé 
sur un CD.

Le prémixage (bounce) d'une piste sur un disque 
contient les éléments suivants :

Pistes audibles : toutes les pistes audibles sont 
intégrées au prémixage. Les pistes coupées 
(Mute) n'apparaissent pas dans le prémixage. 
En cas d'écoute en mode Solo d'une piste ou 
d'une région, seuls les éléments ainsi écoutés en 
Solo apparaissent dans le prémixage.

Automation du volume d'une piste dans la fenêtre Edit

Pour plus d'informations sur l'utilisation de 
l'automation, consultez le Guide de 
référence Pro Tools.

Vue de piste
Point d'inflexion
d'automation pour le volume
Automation : toutes les données d'automation 
pour lesquelles la lecture est autorisée sont lues 
et prises en compte pour le prémixage. 

Inserts et départs : tous les inserts actifs, et 
notamment les plug-in temps réel et les inserts 
matériels, sont pris en compte pour le 
prémixage.

Sélection ou longueur de piste : si vous 
sélectionnez la partie d'une piste, la durée du 
prémixage correspond à celle de la sélection. 
En l'absence de sélection, la durée du prémixage 
continue jusqu'à la fin de la session.

Pour exécuter la commande Bounce to Disk :

1  Sélectionnez File > Bounce to > Disk.

2  Sélectionnez une sortie ou un chemin de bus 
mono ou stéréo en tant que source de prémixage. 

3  Sélectionnez le type de fichier (WAV par 
exemple), le format (mono ou stéréo), la 
résolution (16 bits, par exemple) et la fréquence 
d'échantillonnage (44,1 kHz, par exemple). 

4  Pour modifier la fréquence d'échantillonnage 
du fichier prémixé, sélectionnez un paramètre de 
conversion dans le menu Conversion Quality.

5  Cliquez sur Bounce.

Pour créer un mixage final pouvant être écrit 
sur un CD audio, assurez-vous d'avoir 
sélectionné WAV, stéréo entrelacé, 16 bits 
et 44,1 kHz. 
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Utilisation du dithering pour le mixage 
final

Utilisez un plug-in Dither si vous effectuez un 
prémixage ou un mixage audio à une fréquence 
d'échantillonnage plus faible (par exemple, lors 
du mastering d'une session 24 bits en session 
16 bits pour une sortie CD).

Ce plug-in n'est pas nécessaire pour les 
prémixages ou mixages audio de même 
fréquence d'échantillonnage (par exemple, lors 
du transfert d'une session 24 bits d'un système à 
un autre).

Pour appliquer le plug-in Dither, préférez les 
faders principaux aux entrées auxiliaires. 
En effet, les inserts de fader principal sont des 
opérations post-fader. Avec un fader principal, 
le plug-in Dither traitera toute modification du 
fader de volume de la piste.

Pour mixer de l'audio avec un plug-in Dither :

1  Créez un fader principal et assignez-le au 
contrôle du chemin de sortie audio que vous 
souhaitez mixer ou prémixer.

2  Insérez le plug-in Dither POW-r inclus (ou 
n'importe quel autre plug-in Dither) dans le 
fader principal de la piste, à la suite d'un autre 
plug-in ou insert éventuel. 

3  Dans la fenêtre du plug-in, cliquez sur le 
bouton de résolution (en bits) et sélectionnez 
la fréquence d'échantillonnage de destination 
(20 ou 16 bits).

4  Ensuite, cliquez sur le bouton de mise en 
forme du bruit et sélectionnez le paramètre 
adéquat. Le type 1 convient aux fichiers mono 
tandis que les types 2 et 3 sont destinés aux 
fichiers stéréo.

5  Sélectionnez File > Bounce to Disk pour 
procéder au mixage.
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Conversion de la fréquence 
d'échantillonnage (SRC) lors du mixage

Dès que vous modifiez la fréquence 
d'échantillonnage d'un fichier prémixé (par 
exemple, lors du mixage en 44,1 kHz d'une 
session enregistrée en 48 kHz, en vue d'une 
sortie sur CD audio), vous avez la possibilité de 
spécifier le paramètre Conversion Quality 
(qualité de conversion) qui s'affiche dans la 
boîte de dialogue Bounce to Disk.

Il existe cinq paramètres de qualité de 
conversion, classés par ordre croissant (de Low à 
TweakHead). Plus cette qualité est élevée, plus la 
conversion du fichier prémixé est longue.

Pour plus d'informations sur l'utilisation 
du plug-in Dither et la conversion de la 
fréquence d'échantillonnage pendant le 
mixage, reportez-vous au Guide de référence 
Pro Tools.
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Configuration de MIDI Studio Setup 
(Windows uniquement)
MIDI Studio Setup
MIDI Studio Setup (MSS) permet de configurer 
les contrôleurs MIDI et les générateurs de son 
connectés au système. Il permet également de 
contrôler l'acheminement des données MIDI 
entre le matériel MIDI et Pro Tools.

MSS détecte automatiquement les interfaces 
MIDI et vous permet de personnaliser les noms 
de chaque port MIDI dans le document MIDI 
Studio Setup. 

MSS prend également en charge les noms de 
fichier patch au format XML dans le cadre du 
stockage et de l'importation des noms de patch 
de vos périphériques MIDI externes. 

Vous pouvez importer et exporter l'ensemble 
des configurations MIDI Studio Setup créées 
dans MSS. 
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Fenêtre MIDI Studio Setup

La fenêtre MIDI Studio Setup est organisée en 
trois sections. Les commandes d'affichage se 
trouvent dans la partie supérieure de la fenêtre. 
A gauche, une liste répertorie le nom de tous 
les instruments que vous avez définis. Enfin, 
à droite, la section Properties affiche les détails 
des paramètres MIDI.

Commandes d'interface

Create : ajoute le nom d'un instrument à la liste.

Delete : supprime de la liste le nom des 
instruments sélectionnés.

Import : permet d'importer un fichier MIDI 
Studio Setup existant.

Fenêtre MIDI Studio Setup
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Export : permet d'exporter le fichier MIDI Studio 
Setup actif.

Show Duplicate Emulated Outputs : Si votre 
interface MIDI prend en charge le marquage 
temporel (E/S MIDI par exemple), sélectionnez 
cette option pour afficher dans la fenêtre MIDI 
Studio Setup, outre les ports MIDI du système 
Mbox 2, les ports de sortie horodatés DirectMusic 
ainsi que les ports de sortie émulés dupliqués sans 
horodatage. 

Liste des instruments

La liste des instruments répertorie tous les 
instruments que vous avez définis. Sélectionnez 
un instrument pour afficher ses propriétés dans 
la section Properties de la fenêtre.

Section Properties

Dans cette section, vous pouvez modifier les 
informations relatives aux nouveaux 
instruments ou aux instruments sélectionnés 
dans la liste des instruments.

Dans certains cas, vous devez quitter et 
relancer Pro Tools pour que les interfaces 
MIDI puissent charger ou décharger 
correctement leurs pilotes. Pour plus 
d'informations, consultez la 
documentation de votre interface MIDI.

Section Properties de la fenêtre MIDI Studio Setup
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L'affichage de la section Properties se modifie et 
indique les propriétés de l'instrument sélectionné 
dans la liste des instruments, si celui-ci a été 
défini précédemment.

Pour définir un instrument avec MIDI Studio 
Setup :

1  Sélectionnez Setup > MIDI > MIDI Studio.

2  Cliquez sur Create.

3  Dans le champ Instrument Name, tapez le 
nom de l'instrument, puis appuyez sur la touche 
Entrée.

4  Indiquez le fabricant et le modèle du nouveau 
périphérique dans les menus contextuels 
correspondants. Si le fabricant et le modèle 
de votre périphérique ne s'y trouvent pas, 
choisissez None (aucun).

5  Dans le menu contextuel Input, sélectionnez 
le port d'entrée de l'interface MIDI connectée au 
port de sortie MIDI de l'instrument.

6  Dans le menu contextuel Output, sélectionnez 
le port de sortie de l'interface MIDI connectée au 
port d'entrée MIDI de l'instrument.

7  Activez les canaux MIDI requis (1 à 16) pour 
les options Send Channel et Receive Channel, 
qui déterminent respectivement les canaux 
d'envoi et de réception MIDI.

Si vous n'entrez pas le nom de l'instrument, 
le champ hérite automatiquement des 
informations contenues dans les menus 
contextuels Manufacturer et Model. 



Instrument Name

Dans ce champ, vous pouvez indiquer le nom de 
l'instrument sélectionné.

Manufacturer

Ce menu contextuel contient la liste des 
fabricants de matériel MIDI, issue des fichiers de 
périphériques MIDI au format XML. 

Model

Ce menu contextuel contient la liste de 
périphériques MIDI regroupés par fabricant. 
Cette liste est issue des fichiers de périphériques 
MIDI au format XML contenus dans 
l'installation Pro Tools.

Input Port

Le menu contextuel Input Port contient la liste 
des ports d'entrée disponibles de l'interface 
MIDI. Mbox 2 et toute interface supplémentaire 
MIDI activée sur le système en font partie. 
Ce menu permet de définir et d'afficher le port 
de l'interface MIDI par lequel les données MIDI 
sont envoyées, du périphérique MIDI externe 
spécifié dans le champ Instrument Name vers 
l'interface MIDI.

Pour plus d'informations, reportez-vous à la 
section Prise en charge de noms de patch 
MIDI, page 83.

Pour plus d'informations, reportez-vous à la 
section Prise en charge de noms de patch 
MIDI, page 83.

Si vous choisissez la valeur None pour le port 
d'entrée, l'instrument défini n'apparaîtra 
pas dans le sélecteur d'entrée MIDI. 
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Output Port

Le menu contextuel Output Port contient la liste 
des ports de sortie disponibles de l'interface 
MIDI. Ce menu permet de définir et d'afficher le 
port par lequel les données MIDI sont envoyées, 
de l'interface MIDI vers le périphérique MIDI 
spécifié dans le champ Instrument Name.

Send Channels

La grille Send Channels permet de définir les 
canaux d'envoi du périphérique MIDI spécifié 
dans le champ Instrument Name. 

Receive Channels

La grille Receive Channels permet de définir les 
canaux de réception du périphérique MIDI 
spécifié dans le champ Instrument Name.

Prise en charge de noms 
de patch MIDI
Pro Tools est compatible avec le langage XML 
(Extensible Markup Language) pour l'archivage 
et l'importation des noms de patch des 
périphériques MIDI externes. Pro Tools installe 
les fichiers .midnam des noms de patch d'usine 
par défaut de nombreux périphériques MIDI 
standard. Ces fichiers résident dans des 
répertoires, triés par fabricant, sous 
Program Files\Common Files\Digidesign\ 
MIDI Patch Names\Digidesign.

Si vous choisissez la valeur None pour le 
port de sortie, l'instrument défini 
n'apparaîtra pas dans le sélecteur de 
sortie MIDI. 
nfiguration de MIDI Studio Setup (Windows uniquement) 83



84
Pour importer des noms de patch MIDI dans 
Pro Tools :

1  Notez le nom du périphérique MIDI, indiqué 
dans la fenêtre MIDI Studio Setup (voir MIDI 
Studio Setup, page 81).

2  Vérifiez si la sortie de la piste MIDI est 
correctement attribuée au périphérique MIDI.

3  Cliquez sur le bouton de sélection des patchs 
de la piste MIDI.

4  Dans la boîte de dialogue Patch Select, cliquez 
sur Change.

Bouton de sélection des patchs, fenêtre Edit

Bouton de sélection des patchs, fenêtre Mix

 Boîte de dialogue Patch Select

Bouton de sélection
des patchs

Bouton de sélection
des patchs

Bouton Change
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5  Dans la boîte de dialogue Open, accédez 
au nom du fabricant sous Program Files\ 
Common Files\Digidesign\MIDI Patch Names\ 
Digidesign\<Nom_Fabricant>, puis sélectionnez 
le fichier .midnam pour le périphérique MIDI.

6  Cliquez sur Open.

La liste des noms de patch s'inscrit dans la boîte 
de dialogue Patch Select et le menu contextuel 
Patch Name Bank s'affiche dans le coin 
supérieur gauche de la fenêtre.

Une fois les noms de patch importés dans 
Pro Tools, vous pouvez les utiliser pour ce 
périphérique MIDI dans toutes les sessions.

Pour effacer des noms de patch :

■ Dans la boîte de dialogue Patch Select, cliquez 
sur Clear, puis sur Done.

Boîte de dialogue Patch Select contenant les noms de 
patch

Vous pouvez modifier les fichiers .midnam 
dans un éditeur de texte. Vous pouvez 
également créer vos propres noms de patch 
à l'aide d'éditeurs ou de bibliothèques de 
noms de patch tiers.



annexe b

Configuration d'AMS (Mac OS X 
uniquement)
Audio MIDI Setup
Pro Tools identifie les ports de l'interface MIDI 
comme des ports génériques. Sous Mac OS X, 
l'utilitaire Audio MIDI Setup (AMS) d'Apple 
permet d'identifier les périphériques externes 
connectés à l'interface MIDI et de configurer 
votre studio MIDI pour l'utiliser avec Pro Tools.

Pour configurer votre studio MIDI dans AMS :

1  Lancez Audio MIDI Setup (situé dans le dossier 
Applications/Utilitaires).

– ou –

Dans Pro Tools, sélectionnez Setup > MIDI > 
MIDI Studio.
2  Cliquez sur MIDI Devices. AMS parcourt 
le système à la recherche d'interfaces MIDI 
connectées. Si l'interface MIDI est correctement 
connectée, elle s'affiche avec chacun de ses ports 
numérotés.

3  Pour tous les périphériques MIDI connectés à 
l'interface MIDI, cliquez sur Ajouter périphérique. 
L'icône du périphérique externe s'affiche avec 
l'image du clavier MIDI par défaut.

4  Faites glisser l'icône du nouveau périphérique 
vers l'emplacement de votre choix dans la 
fenêtre.

Boîte de dialogue Audio MIDI Setup, onglet MIDI 
Devices
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5  Connectez le périphérique MIDI à l'interface 
MIDI en cliquant sur la flèche correspondant au 
port de sortie de périphérique approprié et en 
faisant glisser la connexion (câble) vers la 
flèche d'entrée du port correspondant de 
l'interface MIDI.

6  Cliquez sur la flèche correspondant au port 
d'entrée de périphérique approprié et faites 
glisser le câble vers la flèche correspondant au 
port de sortie de l'interface MIDI. 

7  Répétez les étapes 3 à 6 pour chaque 
périphérique MIDI à ajouter à la configuration 
MIDI.

Connexion des entrées et sorties MIDI

Pour supprimer une connexion, sélectionnez 
le câble et appuyez sur la touche Suppr. 
Pour supprimer toutes les connexions, 
cliquez sur Tester config.
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Pour configurer un périphérique MIDI externe :

1  Sélectionnez l'icône de périphérique externe 
et cliquez sur Afficher infos (ou cliquez deux fois 
sur l'icône correspondant au nouveau 
périphérique). 

2  Sélectionnez le fabricant et le modèle 
du nouveau périphérique dans les menus 
déroulants correspondants. Si le fabricant et le 
modèle de votre périphérique ne se trouvent pas 
dans les menus déroulants correspondants, vous 
pouvez saisir vous-même un nom.

Icône de périphérique externe

Attribution d'un nom à un nouveau périphérique MIDI



3  Cliquez sur la flèche de l'option More 
Properties pour ouvrir la boîte de dialogue, 
puis activez les canaux MIDI appropriés (1 à 16) 
pour les options Transmits et Receives. 
Cette opération détermine les canaux qui 
seront utilisés pour envoyer et recevoir des 
données MIDI. 

Les noms de fabricant et de modèle sont 
quant à eux contenus dans un ou plusieurs 
fichiers .middev qui se trouvent dans le 
répertoire Root/Library Audio/MIDI 
Devices. Pro Tools installe un fichier Legacy 
Devices List.middev qui contient des 
informations sur de nombreux 
périphériques MIDI disponibles à la vente. 
Si les noms de fabricant et de modèle d'un 
périphérique externe MIDI ne sont pas 
disponibles dans les menus contextuels 
AMS Manufacturer et Model, vous pouvez 
les ajouter en modifiant le fichier .middev 
dans un éditeur de texte, tel que TextEdit). 

Activation de canaux MIDI
4  Cliquez sur l'image du périphérique. 
La fenêtre s'agrandit pour afficher des images 
correspondant aux divers périphériques MIDI 
(tels que les claviers, les modules, les interfaces 
et les consoles de mixage). Sélectionnez une 
icône pour votre périphérique. 

5  Cliquez sur OK. 

Les noms de périphériques que vous saisissez 
peuvent ensuite être sélectionnés comme entrée 
ou sortie MIDI dans Pro Tools. 

Sélection d'une icône de périphérique

Pour utiliser vos icônes personnalisées, vous 
pouvez placer des fichiers image TIFF dans 
le répertoire /Library/Audio/MIDI Devices/ 
Generic/Images. Vous pouvez ensuite les 
sélectionner dans la fenêtre du 
périphérique AMS.
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Prise en charge de noms 
de patch MIDI
Pro Tools est compatible avec le langage XML 
(Extensible Markup Language) pour l'archivage 
et l'importation des noms de patch des 
périphériques MIDI externes. Pro Tools installe 
les fichiers .midnam des noms de patch d'usine 
par défaut de nombreux périphériques MIDI 
standard. Ces fichiers se trouvent dans des 
répertoires, triés par fabricant, dans /Library/ 
Audio/MIDI Patch Names/Digidesign.

Pour importer des noms de patch MIDI dans 
Pro Tools :

1  Notez le nom du périphérique MIDI, indiqué 
dans la fenêtre Audio MIDI Setup (voir Audio 
MIDI Setup, page 85).

2  Vérifiez si la sortie de la piste MIDI est 
correctement attribuée au périphérique MIDI.

3  Cliquez sur le bouton de sélection des patchs 
de la piste MIDI.

Bouton de sélection des patchs, fenêtre Edit

Bouton de sélection des patchs, fenêtre Mix

Bouton de sélection
des patchs

Bouton de sélection
des patchs
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4  Dans la boîte de dialogue Patch Select, cliquez 
sur Change.

5  Dans la boîte de dialogue Open, accédez au 
nom du fabricant sous /Library/Audio/MIDI 
Patch Names/Digidesign/<Nom_Fabricant>, 
puis sélectionnez le fichier .midnam pour le 
périphérique MIDI.

6  Cliquez sur Open.

La liste des noms de patch s'inscrit dans la boîte 
de dialogue Patch Select et le menu contextuel 
Patch Name Bank s'affiche dans le coin 
supérieur gauche de la fenêtre.

Une fois les noms de patch importés dans 
Pro Tools, vous pouvez les utiliser pour ce 
périphérique MIDI dans toutes les sessions.

Pour effacer des noms de patch :

■ Dans la boîte de dialogue Patch Select, cliquez 
sur Clear, puis sur Done.

 Boîte de dialogue Patch Select

Vous pouvez modifier les fichiers .midnam 
dans un éditeur de texte. Vous pouvez 
également créer vos propres noms de patch 
à l'aide d'éditeurs ou de bibliothèques de 
noms de patch tiers.

Bouton Change
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Dépannage
Sauvegarde de votre travail
Il est vivement conseillé de sauvegarder 
régulièrement votre travail, en particulier avant 
de modifier la configuration du système.

Sauvegarde des données d'une 
session

Sauvegardez fréquemment les informations et 
les données audio d'une session. De nombreux 
supports permettent de sauvegarder des projets 
de différentes tailles, depuis les systèmes de 
sauvegarde automatique sur bande jusqu'aux 
lecteurs optiques haute capacité, en passant par 
les graveurs de CD.

Le meilleur moyen de sauvegarder une session 
dans sa totalité est d'utiliser la commande Save 
Copy In. Cette commande permet d'enregistrer 
sous un nouvel emplacement le fichier de la 
session ainsi que les fichiers qui lui sont associés.

En outre, la fonction Auto Save Backup de la 
page Operation Preferences permet une 
sauvegarde automatique du fichier de 
session pendant l'exécution de Pro Tools.
Sauvegarde de la configuration 
du système

Une fois la configuration de Pro Tools et du 
système terminée, enregistrez une image de 
votre disque système à l'aide d'un utilitaire 
de sauvegarde tel que Norton Ghost (Windows) 
ou Bombich Carbon Copy Cloner (Macintosh). 
Cette opération vous permet, en cas de 
problèmes, de restaurer rapidement la 
configuration et les paramètres de votre 
système.

Problèmes courants

Pro Tools ne démarre pas

Problème

Lorsque vous cliquez deux fois sur l'application 
Pro Tools ou sur un fichier de session Pro Tools, 
l'application ne se lance pas ou affiche un 
message d'erreur. 
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Solutions possibles

◆ Assurez-vous que l'ordinateur dispose de 
suffisamment de RAM pour lancer Pro Tools. 
Reportez-vous à la page relative à la 
compatibilité, sur le site Web de Digidesign 
(www.digidesign.com/compato).

◆ Essayez de redémarrer tout le système. 
Mettez hors tension les interfaces audio, les 
périphériques et l'ordinateur, puis remettez-les 
sous tension dans l'ordre qui convient.

◆ Si vous avez tenté de lancer Pro Tools en 
cliquant deux fois sur un fichier de session 
Pro Tools, procédez comme suit :

• Fermez les messages d'erreur éventuels.

• Cliquez deux fois sur l'application 
Pro Tools.

• Dans Pro Tools, sélectionnez File > Open 
Session pour ouvrir la session.

◆ Réinstallez le logiciel Pro Tools à l'aide du 
CD d'installation Pro Tools. Pour obtenir les 
instructions d'installation, reportez-vous au 
guide d'introduction ou au guide de mise à jour 
Pro Tools.

L'interface audio n'est pas 
reconnue

Problème

Au lancement, Pro Tools ne reconnaît pas 
une interface audio ou une interface audio 
connectée n'est pas disponible.
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Solutions possibles

◆ Eteignez votre ordinateur et vérifiez que tous 
les câbles sont correctement reliés à l'ordinateur 
et aux interfaces audio.

◆ Vérifiez que les paramètres de la boîte de 
dialogue Hardware Setup sont corrects.

Facteurs de performances
Un certain nombre de conditions peuvent 
altérer les performances de Pro Tools, à savoir :

Connexions réseau : fermez toutes les 
connexions de réseau si elles ne sont pas utilisées 
pour l'échange de données audio en réseau.

Applications d'arrière-plan : tous les utilitaires 
logiciels qui s'exécutent en arrière-plan ou 
provoquent une activité du disque (logiciels 
antivirus, optimiseurs de disque ou sauvegarde 
de fichiers) doivent être désactivés ou 
supprimés.

Economiseurs d'écran : il est conseillé de 
désactiver les économiseurs d'écran de votre 
ordinateur avant d'exécuter Pro Tools.

Fonctionnalités d'économie d'énergie : Certaines 
fonctionnalités automatiques d'économie 
d'énergie, par exemple, celles qui ralentissent 
le disque dur, peuvent altérer les performances 
de Pro Tools. Il est préférable de les désactiver.

Pour plus d'informations sur les solutions 
possibles suivantes, reportez-vous au guide 
de démarrage.



Avant d'appeler le support 
technique de Digidesign

Enregistrez votre système

Enregistrez immédiatement votre produit après 
avoir pris connaissance des informations du 
formulaire fourni avec le système Pro Tools. 
En vous enregistrant, vous bénéficiez d'une 
assistance technique gratuite ainsi que d'offres 
de mises à jour. Il s'agit donc d'une étape 
importante pour tout nouvel utilisateur.

Utilisez les ressources Digidesign

Outre les versions papier et PDF des Guides 
Pro Tools, votre système contient les sources 
d'information suivantes :

Fichiers Lisez-moi : ils contiennent les 
informations les plus récentes et les problèmes 
connus inhérents aux configurations des logiciels 
et des dispositifs Pro Tools. Les fichiers Lisez-moi 
s'installent dans le dossier Documentation à 
l'installation de Pro Tools.

Answerbase : cette base de données répertorie 
les problèmes et les erreurs de DAE les plus 
fréquents ainsi que leur solution, à partir des 
informations les plus récentes fournies par 
l'équipe de support technique de Digidesign. 
Elle s'installe dans le dossier Digidesign à 
l'installation de Pro Tools. Elle est également 
disponible sur le site Web de Digidesign 
(www.digidesign.com).

Site Web www.digidesign.com : le site Web 
de Digidesign (www.digidesign.com) est la 
meilleure source d'informations en ligne pour 
optimiser votre système Pro Tools.
Rassemblement d'informations 
importantes

Digidesign souhaite vous aider à résoudre 
vos problèmes le plus rapidement et le plus 
efficacement possible. En réunissant les 
informations ci-après avant de contacter le 
support technique, vous faciliterez le diagnostic 
de votre problème. Prenez quelques minutes 
pour réunir ces informations élémentaires.

Informations sur le système

L'ordinateur :

• marque, modèle, vitesse du processeur ;

• quantité de RAM ;

• système d'exploitation (version de Mac OS 
ou de Windows) ;

• pilotes, utilitaires de disque et toute 
application relative au système installé.

Le dispositif Digidesign :

• type de cartes, d'interfaces ou de 
périphériques

Les disques durs :

• marque, modèle ;

• taille du disque dur (Go) ;

• vitesse du disque (en trs/mn) ;

• type de disque (SCSI, FireWire, IDE/ATA) ;

• utilitaire servant à formater le disque dur ;

• nombre et taille des partitions du disque.

Les logiciels Digidesign :

• version du logiciel Pro Tools ;

• version du plug-in ;

• autres logiciels Digidesign ;

• autres plug-in fournis par des partenaires 
de développement de Digidesign.
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Autre dispositif

Pour plus de détails sur le fonctionnement, 
consultez la documentation du fabricant. 

Les composants de dispositif supplémentaires 
les plus utilisés sont les suivants :

• cartes 1394 (FireWire) pour les systèmes 
Windows (fabricant, modèle) ;

• cartes d'acquisition vidéo (fabricant, 
modèle).

Visitez la page relative à la compatibilité sur le 
site Web de Digidesign (www.digidesign.com/ 
compato) pour vous assurer que votre dispositif 
peut prendre en charge le système Pro Tools.

Autres logiciels

Si vous utilisez d'autres applications audio ou 
vidéo, consultez la documentation du fabricant 
pour en savoir plus sur leur fonctionnement.

En cas de problème, répertoriez tous les autres 
logiciels en cours de fonctionnement.

Informations de diagnostic

Notez toutes les erreurs de DAE ou autres codes 
d'erreur rencontrés. Vérifiez également si le 
problème peut se reproduire dans des 
conditions différentes, par exemple, avec une 
autre session ou après la modification de 
paramètres tels que la taille du buffer matériel. 
Guide Introduction à Mbox 2
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Grid 71
Shuffle 71
Slip 71
Spot 71

Edition, outils
crayon 71
main 71
outil de scrubbing 71
outil de trimming 71
outil Smart 71
sélecteur 71
zoom 71

Emplacements mémoire 60
contrôle du zoom 63
définition 60
rappel 60

Enregistrement
audio 66
entrées analogiques 42
entrées numériques 44
MIDI 67, 69

Entrées
analogique 41
écoute 37
gain 39
numérique 40

F
Faders principaux 55, 56, 77
Fenêtres 48

fenêtre Edit 48
fenêtre Mix 48, 74
fenêtre Transport 49, 54

Fondu
fichiers 47
Guide Introduction à Mbox 2
G
Gain

casque 36
entrée 39

Grid, mode 71

H
Hardware Buffer Size, paramètre 16, 26

I
I/O Setup, boîte de dialogue

Macintosh 29
Windows 19

Importation
audio 63
glisser-déposer de fichiers 65
MIDI 64

Indicateurs
alimentation fantôme 38
connexion USB 36
niveau de crête 38
S/PDIF 36

Insert
plug-in 78

Installation de Pro Tools LE
Macintosh 24
Windows 13

Installation de QuickTime (pour Windows) 13
Instrument

pistes 55, 57

L
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voir écoute
Lecteur, formatage

Macintosh 23
Windows 11

Lecteur, maintenance
Macintosh 23
Windows 11, 12

Lecture
audio 67
début et fin 54
MIDI 70

Link Edit et Timeline Selection
options 59

Logiciel de prise en charge Ethernet 14
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MIDI
configuration (pour Macintosh) 85
configuration (pour Windows) 81
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connexions 44
édition 70
importation 64
pistes 55, 57

MIDI Studio Setup (MSS) (pour Windows) 81
Mix

commande (Mbox 2) 37
fenêtre 48, 74

Mixage 74, 79
conversion de fréquence d'échantillonnage 80
résolution en bits 80

Mono, touche 37

O
Optimisation du système

Macintosh 21, 22
Windows 7, 8, 9, 10

P
Panoramique, curseur 75
Paramètres de gestion de l'alimentation

Macintosh 22
Windows 8

Paramètres système
buffer matériel, taille 16, 26
I/O Setup 19, 29
paramètre Sample Rate 18, 28
pourcentage d'utilisation du processeur 17, 27
RTAS Processors 16, 27
source d'horloge 19, 29
taille du buffer de lecture DAE 17, 28
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Macintosh 88
Windows 84
Pilotes audio
ASIO, pilote (pour Windows) 14
CoreAudio, pilote (pour Macintosh) 25
WaveDriver, pilote (pour Windows) 14

Pistes 55
audio 55, 56
création 55
enregistrement audio 66
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entrées auxiliaires 55, 56, 75
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instrument 55, 57
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lecture MIDI 70
MIDI 55, 57
types 55
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Playlists 72
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AudioSuite 77
Click 51
dithering 80
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RTAS (Real-Time AudioSuite) 77
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Pro Tools LE

configuration (pour Macintosh) 26
configuration (pour Windows) 16
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Q
QuickTime

installation (pour Windows) 13

R
Ratio, commande (Mbox 2) 37
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édition 72
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chef d'orchestre 50
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Tempo 50
temporelle 50

Retour 76
RTAS Processors, paramètre 16, 27

S
S/PDIF 40

indicateur d'entrée 36
mise en miroir 44

Sample Rate, paramètre 18, 28
Scrubbing
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Sélecteur

de hauteur de piste 61
outil 71

Sessions 47
création 47
duplication 53
enregistrement 47, 52
enregistrement de copies 53
utilisation 59

Shuffle
mode 71

Slip, mode 71
Smart, outil 71
Solo, bouton 75
Sorties

numérique 40
S/PDIF, mise en miroir 44
sorties d'écoute 41

Source d'horloge, paramètre 19, 29
Internal, paramètre 19, 29
S/PDIF (numérique), paramètre 19, 29
sortie numérique 45

Sources
analogique 41
instrument 41
ligne 41
micro 41
numérique 40
sélection 39

Spot, mode 71
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T
Tempo 50, 51
Touches, commandes 6
Transport

fenêtre 49, 54
Trimming

outil 71

U
Utilitaire MacDrive (pour Windows) 15

V
Voies, commandes
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panoramique 74
solo 74
volume 74
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W
WaveDriver (pour Windows) 14

Z
Zoom 61
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